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) EDITORIALE

Questa edizione é stata creata usando:

BENVENUTI AL PRIMO FULL CIRCLE DEL 2013!

P roprio cosi! Un nuovo anno, un nuovo Full Circle! Credo che Aprile di quest'anno segnera
il nostro sesto anno. Wow! Comunque sia, torniamo al presente. Questo mese, abbiamo
i soliti articoli su Python, LibreOffice, Inkscape e gli How To di Blender. A loro si unisce un
interessante HowTo su come far apparire il vostro Ubuntu in stile Gnome 2 ("Gnome 2 style",
da non confondere con "Gangnam style").

The Document Foundation

L'ex ospite del podcast, Ed Hewitt, accende un dibattito questo mese a pagina 34 coniil
suo parere su come il recentemente annunciato 'Telefono Ubuntu' (come viene .
amichevolmente chiamato in Internet) sia inevitabilmente destinato all'insuccesso. Dite la Full Circle Podcast

vostra con i commenti in un articolo o via e-mail. Rilasciato mensilmente, ogni
episodio tratta tutte le principali
notizie, opinioni, recensioni,

Per natale mi e stato regalato un TV-Box NSZ-GS7 Sony Google. Leggete la mia i tervicke e Feedback dei lettori del

recensione a pagina 37 di questo numero. E se vi fosse stato regalato qualcosa di mondo di Ubuntu. Il Side-Pod & una
tecnologico per le festivita, magari fatene una recensione. Ricordate: siamo una rivista per la novita, & un breve podcast aggiuntivo
comunita di Ubuntu Linux. Linux. Questo significa che potete recensire o scrivere su (senza uscite regolari), inteso come

un'appendice del podcast principale.
Qui vengono inseriti tutti gli
argomenti di tecnologia generale e

qualsiasi *buntu, tecnologia Linux o Android, o distribuzione.

Ho fatto anche un paio di piccole modifiche al layout questo mese. Non preoccupatevi, materiali non inerenti Ubuntu che
non € niente di importante. Solo piccole modifiche a sottotitoli, capolettere e altre cose sui non rientrano nel podcast principale.
font da dietro le quinte. | sottotitoli senza capolettera fanno troppo "2012"... -

Ospiti:
L. . . * Les Pounder
Con i migliori saluti, e restate in contatto E E * Tony Hughes
[ ]

Ronnie 1 « Jon Chamberlain . H " },}

ronnie@fullcirclemagazine.org * Oliver Clark

http://fullcirclemagazine.org

Ia] [, OO (¢ Eo
Chvwvriload
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Ubuntu nel 2013

M ark Shuttleworth condivide i
suoi pensieri su Ubuntu nel
2013: "E importante per me, e per la
piu ampia comunita di Ubuntu, che le
persone siano in grado di trarre
qualche vantaggio dal nostro

persone in gamba le cui necessita
erano soddisfatte da quello che

esisteva nel passato. Noi continuiamo :

a curare la manutenzione delle
vecchie versioni di Ubuntu affinché
loro possano usufruire di questi

Vogliamo dare forma al futuro, il che
significa esplorare un territorio
sconosciuto, incerto e facile da
criticare. Ecco perché nel 2013 Unity
sara sui dispositivi mobili - portando
Ubuntu su telefoni e tablet."

Per saperne di piu:

rchives/1221

E UFFICIALE: ORA
UBUNTU SI ADATTA Al
CELLULARI

UBUNTU NEWS

Scritto dal gruppo Ubuntu News

J ane Siber, CEO di Canonical, ha

annunciato che Ubuntu arrivera

: presto sui cellulari. Siber ha anche

© annunciato una nuova strada per la

. realizzazione di applicazioni per il

: differente fattore di formai.e. QML
© basato su Ubuntu SDK e un ulteriore
: lavoro per Ubuntu per cellulari.
impegno. Sappiamo che ci sono molte :

: Annuncio ufficiale: _
: http://blog.canonical.com/2013/01/0 :
2/its-official-ubuntu-now-fits-phones/ : android-killer-probably-not-1.html
. Gli obbiettivi di Ubuntu

. Smartphone per il successo delle
: economie in via di sviluppo -

: http://www.technologyreview.com/n :
: ews/509646/ubuntu-smartphone-
: aims-for-success-in-developing-

: economies/

. UBUNTU PHONE

strumenti su una piattaforma stabile.

buntu Phone é ancora in voga
tra le notizie, in particolare con

. le demo di Mark Shuttleworth, Jono
: Bacon el resto del team di Canonical :
- al Consumer Electronics Show di Las
© Vegas in questa settimana!

caratteristiche, demo di layout,

esperienza sul campo -
: https:/www.youtube.com/watch?v=q :
: E-QPSATASO

: E ora continua a leggere gli articoli :
. che hanno catturato la nostra

: attenzione questa settimana:

. ILnuovo Ubuntu phone é un

. Android-killer? Probabilmente no. -
. http://www.datamation.com/open-

source/is-the-new-ubuntu-phone-an-

. Ubuntu On A Phone o Firefox OS:
. chi spaventa di piu l'lPhone e
. Android? -

: Guardate questo breve video di Mark heep:/f www.techweekeurp pe.co.ukfc ;
: N : omment/ubuntu-phone-firefox-os-
: mentre fa una prova, o uno pit lungo :

http://www.markshuttleworth.com/a : di jono Bacon:
. Dimostrazione di Ubuntu Phone OS : Linux Phone potrebbe farcela -
. by Mark Shuttleworth al CES 2013 - : P

: http://www.youtube.com
: watch?v=RO7QbCqFY7Y

Ubuntu OS per SmartPhone:

. linux-iphone-androi-103206 :
: I migliori 5 motivi per i quali Ubuntu :

. http://www.zdnet.com/top-5-

: reasons-the-ubuntu-linux-phone-
might-make-it-7000009721/

. Irivali linux del Mobile Ubuntu e

Sailfish potrebbero condividere le

Full circle magazine #69 @ 4

. AP-

http://www.techweekeurope.co.uk/n

. ews/linux-ubuntu-sailfish-plasma-
: active-103978

Scarica Ubuntu Phone, il sorgente

: sara "pronto per fine Febbraio" -

. http://www.omgubuntu.co.uk/2013/
: 01/ubuntu-phone-download-will-be-
: ready-late-february

: Canonical scuote il mobile con

. Ubuntu For Phones -

. https://www.linux.com/news/embed
. ded-mobile/mobile-linux/688686-

: canonical-shakes-up-mobile-with-

. ubuntu-for-phones

Ubuntu al CES -

http://www.jonobacon.org/2013/01/
: 13/ubuntu-at-ces/

. FELICE TRECENTESIMA
. EDIZIONE DELLE NEWS
. SETTIMANALI DI

. UBUNTU

WN si e evoluto nella sua forma
attuale con l'aiuto di molte

: persone di tutta la Comunita di

© Ubuntu. La dedizione, l'impegno e la
: passione del team di Ubuntu News

© che ha garantito alla comunita un

ﬂ- indice ©
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UBUNTU NEWS

posto a cui rivolgersi per un
sommario settimanale di Ubuntu,
incredibile. Grazie soprattutto a
Elizabeth Krumbach, Nathan Handler
e a tutti gli altri per aver
automatizzato un processo che
richiede del tempo. Un grazie agli
scrittori delle sintesi, ai recensori e al
nostro guru dei social media Jasna
Benci¢. Grazie a tutti coloro che
supportano UWN contribuendo o

edizioni e per Ubuntu, in tutte le sue
forme!

, Congratulazioni al team di
Ubuntu Weekley

per il raggiungimento della
trecentesima edizione! UWN é una
sintesi significativa delle attivita ad
ampio raggio nella Comunita di
Ubuntu e fornisce una guida preziosa
per il progetto, non importa il vostro

catturano la mia attenzione -
solitamente questa é una finestra per
le comunita come LoCo News, Ubuntu
Cloud News, e Planet e la blogosfera.
UWN accuratamente e con precisione
cattura la vasta e frenetica attivita
della comunita in modo da non dover
trovare altre pubblicazioni. Grazie a
tutti quelli che hanno contribuito a

UWN negli anni - il vostro supporto per
Ubuntu e per i lettori che fanno

. affidamento sul vostro lavoro per
. capire quello che sta succedendo nella
. comunita di Ubuntu é meraviglioso!"~
. Jane Silber, CEO di Canonical

, Congratulazioni per la
vostra trecentesima

. edizione! Che bel traguardo! Grazie

. all'UWN news team per il vostro duro
comprandolo! Siamo qui per altre 300 :
. l'impegno come questo che rendono la :
: comunita cosi sorprendente.

. Continuate cosi, congratulazioni per il
: vostro successo." ~ Leann Ogasawara,
. Manager del team di Ubuntu Kernel,
Newsletter (passato, presente e futuro)

lavoro. Sono la collaborazione e

Canonical

/

Congratulazioni al team di
Ubuntu News per aver

. spinto la newsletter settimanale di
. Ubuntu (UWN) alla trecentesima

. edizione!!! UWN é una buona fonte per :
livello di partecipazione. Lo leggo quasi
ogni settimana sul wiki, do un‘occhiata
al sommario e poi salto alle sezioni che
. 0 le nuove funzionalita che sono

. implementate, UWN é fatto su misura
. per fornire queste news. Controllo la

. newsletter settimanale di Ubuntu che
. ogni volta ricevo attraverso Gmail, di

. solito faccio attenzione ai "Benvenuto
: nuovo membro e sviluppatore" (per

* congratularmi con le persone che

ottenere le pit recenti informazioni
nella comunita di Ubuntu e Linux. Se

ottengono la membership) e "The

Planet" (dove si trovano le nuove
funzioni e i nuovi teams). Grazie a tutti

. quelli che hanno contribuito a UWN per

questa ottima newsletter,

. specialmente a Elizabeth Krumbach,

. Nathan Handler e gli altri editori.

. Grazie UWN!" ~ smartboy abbonato a
. UWN

, , Lavoro con il team di
: Ubuntu News dal 2010 e ho
. assunto il ruolo di coordinatore :
principale dei rilasci delle edizioni dalla
. metddel 2011. In questo periodoho ~ : da:
- lavorato con dozzine di persone :
. meravigliose, incluso Nathan Handler
:con cui ho lavorato per rendere molto
. piti veloce la nostra divertente

. collezione di script di Perl e Python.

. Jasna Bencic che ha lavorato sodo non
. solo per raccogliere gli articoli durante
. la settimana, ma che agisce ancheda
. scrittrice del sommario, editor e guru

dei social media, Amber Graner che é

. stata felice di darci dentro con le

. release quando sono stata in viaggio e
volete vedere cosa fanno i diversi team, :
. fatto affidamento per le recensioni

. editoriali ogni settimana. Infine, é

. sempre un piacere incontrare e

. chiacchierare con i nostri lettori e i

. feedback che ho ricevuto in occasione
. di conferenze ed eventi casuali ai quali
. ho partecipato, sono stati essenziali per :
*miglioramenti che abbiamo fatto nel

Jimm Connett e Matt Rudge a cui ho

corso degli ultimi due anni. Grazie a
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tutti per renderci quello che siamo oggi
e felice trecentesima edizione!" ~
Elizabeth Krumbach, Editrice di UWN

Full Circle Magazine desidera
congratularsi con Ubuntu Weekly
News per la sua trecentesima
edizione

Molte grazie a Ubuntu News Team
per il loro contributo questo mese.

Le novita di questo mese provengono

. https://wiki.ubuntu.com/UbuntuWee
. klyNewsletter/Issue298
. https://wiki.ubuntu.com/UbuntuWee
. klyNewsletter/Issue299

https://wiki.ubuntu.com/UbuntuWee
klyNewsletter/Issue300
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Google Music

-,
C ome molti di voi forse gia sanno,

Google Music e stato
recentemente esteso anche a nazioni
al di Fuori degli Stati Uniti d'America. D|
conseguenza, vi ho finalmente avuto
accesso dalla Germania, e ho subito
iniziato a caricare la mia collezione di
musica nel cloud. Dal momento che
non sono sempre su uno dei miei
computer personali e possiedo piu
dispositivi Android, avere accesso alla
mia musica da qualsiasi luogo era
piuttosto attraente. Non c'é niente di
peggio per me che essere bloccato a
lavorare in IT con il computer di
qualcun altro senza musica da
ascoltare, soprattutto se so di dovervi
stare per un lungo periodo di tempo.
Sto usando Google Music da circa 2
mesi, il che significa che e giuntoiil
momento per un articolo!

Per chi non € a conoscenza di cosa
sia Google Music, si tratta diun
servizio gratuito offerto da Google.
Esso consente essenzialmente di

tua musica da qualsiasi browser web,
di sincronizzare il cloud con i personal
computer utilizzando 'applicazione
Music Manager, e consente ai

Scritto da Lucas Westermann

dispositivi Android l'accesso completo
al cloud, dal quale si pud prendere e
g scegliere quali specifiche canzoni

tenere in locale sul dispositivo.

LA CONFIGURAZIONE

La configurazione del

: cloud é abbastanza

. facile. Si awvia

- l'applicazione

: Music Manager, si

. seleziona cio che

: sidesidera

© sincronizzare (e

© se sincronizzarlo

© automaticament

: @0 meno), e poi

© iniziare il processo.

. L'applicazione sembra
: carichi un massimo di due o

© tre canzoni contemporaneamente, e

: per le mie circa 2.000 canzoni, ¢i sono
- volute tra le 4 e le 6 ore per caricare

© (ad una velocita media di caricamento
. di 50 KB/s). Per questo motivo il

personale, e vi permette di ascoltare la :

coloro che hanno un caricamento

lento.

LA GESTIONE

Orail negozio Google Play offre

: anche lo scaricamento della musica,
: con un regime di prezzi simile al

© negozio iTunes o ad Amazon. In

© Germania, sembra che la scelta nonsia :
© cosi completa come dovrebbe essere,
© soprattutto per gli artisti meno

conosciuti. Tuttavia, alcuni
MP3 sono disponibili

se per filtrarli e
un modo
semplice.
Pertanto,
aumentare le

dimensioni della

musica dovrebbe

Gestire le vostre playlist e le

© informazioni sui brani musicali &

: altrettanto semplice come con

: qualsiasi altro programma di musica.

: La cosa bella & che se si modifica una

© delle playlist che hai impostato come
© "tenere sul dispositivo" in tuttii sistemi :
: Android, si scaricano

© automaticamente i nuovi file, il che &

* una bella soluzione. La mia collezione

di musica € completamente
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. organizzata con le copertine degli

- album e le informazioni complete sulla
: canzone, per questo motivo non posso
- dirvi se il servizio cloud aggiorna

: automaticamente le informazioni, o

. quanto facilmente completi quelle

: mancanti. Immagino che sia piuttosto

. indolore. Ogni brano puo essere

: scaricato dalla pagina web fino ad un
gratuitamente, anche : massimo di 2 volte, e un numero

' - infinito attraverso il Music Manager,
trovarli non esiste : per quanto posso dire. Questo é utile

: nel caso abbiate bisogno di un accesso
. rapido ad un MP3 senza passare

: attraverso alcuna configurazione

© aggiuntiva. Per quanto ne so, &

: necessario configurare il computer per
vostra collezione di - il caricamento prima di poter

: sincronizzare automaticamente i nuovi
essere abbastanza Facile! . file. Non ho ancora configurato il

: caricamento sul mio portatile, il che

- rende difficile dirlo con certezza.

. Ricordo di aver awiato il processo e

. poiil portatile ha cominciato a caricare
. gliMP3 normalmente, sebbene non

: siano apparsi duplicati nel mio

. database cloud. Questo

. probabilmente significa che Google

- filtra ed esclude i duplicati dopo che

: sono stati caricati - quindi ricordatevi

che state effettivamente caricando la

libreria due volte senza una particolare

ﬂ- indice ©
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ragione. Potrei sbagliarmi, ma sembra
funzioni proprio cosi. Se qualcuno ha
esperienze diverse, me lo faccia
sapere via e-mail.

LA QUALITA

| file caricati vengono convertiti in

caso contrario, i file sembrano
mantenere il loro formato (per i miei
dispositivi gli MP3 sono tutti di
altissima qualita con bit-rate variabile).
Lo streaming su una rete mobile ha
una qualita inferiore, al fine di salvare
la larghezza di banda/gestire le

si utilizza una rete senza fili, la qualita
dell'audio & simile a quella di un file
locale riprodotto su uno dei miei
dispositivi. Tuttavia, dando inizio ad
una lista si dovra occasionalmente
attendere un paio di secondi peril
buffering. Una volta avviata la
riproduzione, pare non ci siano pause
tra le canzoni (con 'eccezione di
quando ci sono troppe diminuzioni di
larghezza di banda/velocita
disponibili).

LA RIPRODUZIONE

La riproduzione di musica
direttamente dall'archivio nel cloud &

possibile solo attraverso un browser
web su dispositivi non mobili (laptop,

. PC, ecc)) Se si dispone di un dispositivo :
. mobile con Android, l'accesso e la

. riproduzione della musica

. direttamente dalla nube é possibile

. con l'app Google Music. Questo non
. dovrebbe succedere con qualsiasi

. sistema operativo non-Android. Non

MP3 a 320 kbps se sono inun formato : > 8 A
. c'einoltre il supporto peri tasti

non supportato, come FLACo OGG.In : ) o k .
: multimediali, o per le informazioni di

- riproduzione in Conky. Vi &, tuttavia,

: una estensione per Chrome chiamata
: Music Plus (sviluppato dal direttore di
. Lifehacker), che offre altre

© caratteristiche, come ad esempio un

. controller di popup, lo scrobblig per
velocita inferiori di una rete mobile. Se : last.fm, le n°t'ﬁCh,e per HTMLS, ecc.

: Per un approfondimento, controllate

. la sezione ulteriori letture.

Google Music offre la possibilita di

. creare playlist in base a una canzone
. che comprenda sia musica di proprieta :
. sia musica disponibile nel negozio. :
: Sembra che non tutti gliMp3in

: streaming vengano esegquiti in tutta la
. lunghezza, ma & una scelta eccellente
. per la ricerca di nuova musica.

 CONCLUSIONI

Si tratta di un servizio gratuito

- molto utile da usare nel caso in cui si

ascolti spesso la propria musica dai

dispositivi mobili (ad esempio da un
telefono o da un tablet), nei quali &
preferibile non avere le copie locali di

caricato recentemente.

A causa delle restrizioni per la

. riproduzione, non vedo nel futuro

. prossimo Google Music comeil

: sostituto di un riproduttore locale di

: musica, ma rende sicuramente la vita
: un po' piul facile per organizzare la

© vostra musica su pit dispositivi. Se voi
: siete una persona come me che & :
. costantemente alla ricerca di altri brani :
* da ascoltare, si potranno anche :

apprezzare alcune delle funzionalita
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piu avanzate offerte da Google.

. ULTERIORI LETTURE
©0gni canzone per Non occupare spazio. :

© Questa é anche una soluzione

: meravigliosa per chi ha problemi nella
: sincronizzazione della musica conun

. dispositivo Android, in quanto evita

. efficacemente la questione della

. compatibilita. Se possedete un :
. computer portatile con spazio limitato, :
sicuramente apprezzerete molto :
: questo sistema, anche se ci sono

. alcune restrizioni quando si utilizza

: Google Music direttamente dal cloud.
. Infine, se si dispone di grandi quantita
- dimusica, o si ha una connessione

: Internet lenta, questo probabilmente
© non & per voi. Pud sicuramente essere
© un sistema di backup nel cloud pergli
: acquisti di musica, o per il backup di

. alcune canzoni preferite, in quanto ci
- sono molti controlli su cid che & stato

. https://chrome.google.com/webst
. ore/detail/ipfnecmlncaiipncipkgijb
. oddcdmego —Music Plus

. http://music.google.com - Sito di

. Google Music

ik

=

Lucas haimparato tutto quello chesa
danneggiando ripetutamente il suo sistema,
non avendo nessuna alternativa ha quindi
dovuto imparare come ripararlo. Potete
scrivere a Lucas presso: lswest34@gmail.com.
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a volta scorsa abbiamo avuto una

discussione di massima sulle API di :
TVRag web. Ora inizieremo a guardare :
. prego inoltre di considerare di :
© sostenere i loro continui sforzi facendo :
: una donazione. 5

la scrittura del codice per lavorarci.

L'obiettivo di questa parte é di
iniziare il processo di creazione del
codice, che sara un modulo riusabile

che potra essere importato in qualsiasi :
. informazioni, tre routine che saranno
© usate per mostrare le informazioni

© (assumendo che stiamo in modalita
Sebbene le API TVRage cidanno un :
. fareil lavoro, ancora supponendo che
© si stia lavorando in modalita “stand

: alone”.

programma python e fornira un facile
accesso alle API.

certo numero di cose da poter fare, e
molte di piu la versione registrata, ci
concentreremo solo su queste tre
chiamate:

1 - Cercare la trasmissione tramite
nome e ottenere lo ShowID

2 — Ottenere le informazioni sulla
trasmissione in base allo ShowID

3 - Ottenere delle informazioni sullo
specifico episodio in base allo ShowID

La volta scorsa vi ho mostrato le
chiamate API “non registrate” e
accessibili da chiunque. Questa volta
useremo le chiamate registrate,
utilizzando una mia chiave di
registrazione. Sto per condividere con
voi questa chiave (TVRage é a
conoscenza del fatto). Comunque vi

HOW-T0

Scritto da Greg Walters

chiedo il favore, se userete le API, di

stiamo per creare (benché non tutte
: questa volta. Voglio lasciare spazio ad
- altro in questo numero).

; def FindIdByName (self,
: showname, debug = 0)

. def GetShowInfo (self,
: debug = 0)

; def GetEpisodelist (self,
: showid, debug = 0)

E def DisplaySearchResult (self,
: ShowListDict)

" def DisplayShowInfo (self, dict)

registrarvi e ottenere la vostra chiave
personale e di non abusare del sito. Vi

Creeremo tre routine principali per :

fare le chiamate e restituire le

“stand alone”) e una routine Main per

Ecco quila lista delle routine che

showid,

Programmare In Python: Parte 40

; def DisplayEpisodelist (self,
! SeriesName,
: Episodelist)

SeasonCount,

! def main()

La routine FindByName prende

una stringa (showname), effettua la

chiamata alle API, analizza la risposta

: XML e ritorna una lista di trasmissioni
- che coincidono con le informazioniin
© un dizionario, cosi questa sara una lista
- di dizionari. GetShowlInfo prende lo

: showid dalla routine precedente e

© ritorna un dizionario di informazioni

© relative alle serie. Anche

© GetEpisodeList usa lo showid dalla

© precedente routine e ritorna una lista
- di dizionari contenenti informazioni

© per ciascun episodio.

Useremo una serie di stringhe per

E self .ApiKey =
: "Itnl8IyY1hsR9nOIP6zI"

; self .FindSeriesString = :
: "http://services.tvrage.com/myf
: eeds/search.php?key="

Full circle magazine #69 @ 8

La chiamata che abbiamo bisogno

diinviare (per ottenere una lista di
. informazioni sulle serie con l'ld della
. serie) potrebbe essere:

http://services.tvrage.com/myfeeds/s
. earch.php?key=Itnl8lyY1hsROn0IP6zI&
: show={ShowName}

Uniamo la stringa cosi...

! strng = self.FindSeriesString +
! self.ApiKey + "&show=" +
: showname

Per gli scopi del test usero una

. trasmissione dal titolo “Continuum”

. che, se non ['avete mai vista, € un

. meraviglioso spettacolo di

. fantascienza sulla rete Showcase fuori
. dal Canada. Usero questa trasmissione

: . ; . © per alcune ragioni. Primo, ci sono solo
. tenere la chiave e 'URL di base per poi : P J

© aggiungerci quello di cui abbiamo

: bisogno. Per esempio, considerate il

: seguente codice (lo svilupperemo pit
© tardi).

. (al momento della scrittura) due

: trasmissioni che corrispondono alla

. stringa di ricerca “Continuum”, cio

. rende facile il debug, e in secondo

. luogo c'é attualmente solo una

: stagione di 10 episodi con cui avere a
. che fare.

Dovreste avere un'idea sul cosa si

: sta per cercare con le routine di analisi,

cosi ho messo le chiamate con ['URL

i‘ance“
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completo qui sotto per poterle testare
prima di iniziare con la codifica.

Cercare per nome della trasmissione...
http://services.tvrage.com/myfeeds/s

show=continuum

Recuperare le informazioni sulla serie
usando lo ShowID (sid)
http://services.tvrage.com/myfeeds/s

zI&sid=30789

Recuperare la lista degli episodi e le
informazioni usando lo showID (sid)

http://services.tvrage.com/myfeeds/e
pisode_list.php?key=Itn(8lyY1hsR9nOI :

P6zI&sid=30789

Ora che abbiamo ottenuto tutto
questo, iniziamo con il nostro codice.

Creeremo un file dal nome

“tvrage.py”. Lo useremo per uno o due :

dei prossimi numeri.

Cominceremo con gliimport
mostratiin alto a destra.

Potete notare che stiamo per
usare ElementTree per fare ['analisi
del XML e urlib per le comunicazioni
internet. La libreria sys & usata per
sys.exit.

: quattro righe sono le nostre stringhe
: parziali per costruire ['URL per la

: funzione che vogliamo usare :
. (GetEpisodeListString dovrebbe stare :
howinfo.php?key=Itnl8lyY1hsROn0IP6 :

Imposteremo ora il ciclo principale
in modo tale che possiamo testare le #

: cose mano a mano che procediamo (in | #=========================================================
: basso a destra). Ricordate che questa
- & 'ultima cosa nel nostro file sorgente. :
earch.php?key=Itnl8lyY1hsRIn0IP6zI& : :

from xml.etree import ElementTree as ET
import urllib
import sys

Come detto prima, le prime con un timeout predefinito di 8

- righe inizializzano le liste che useremo :
© piti tardi.
: . urllib.urlopen con il nostro URL

: generato e riceveremo (speriamo) il
. nostro file XML nell'oggetto usock.

. Chiamiamo la configurazione per

Primo impostiamo la stringa che
: sara usata come URL (in mezzo a

tutto su una linea). Le ultime quattro destra). Quindi impostiamo il socket

def FindIdByName (self, showname,debug = 0):
strng = self.FindSeriesString + self.ApiKey + "&show=" + showname
urllib.socket.setdefaulttimeout (8)
usock = urllib.urlopen (strng)
tree = ET.parse (usock) .getroot ()
usock.close ()
foundcounter = 0
self.showlist = []

$===========================================================
# Main loop

# ___________________________________________________________
if name == " main "

Ora iniziamo la nostra classe. Il nome & “TvRage”. Creeremo inoltre la routine __init__.

class TvRage:
def _ _init__ (self):

self .ApiKey = "Itnl8IyY1hsRO9nOIP6zI"
self.FindSeriesString = "http://services.tvrage.com/myfeeds/search.php?key="
self.GetShowInfoString = "http://services.tvrage.com/myfeeds/showinfo.php?key="
self.GetEpisodelListString =

"http://services.tvrage.com/myfeeds/episode_list.php?key="
self.ShowlList = []
self.ShowInfo = []
self .Episodelist
self .EpisodeItem

[]
[1

Full circle magazine #69 @ 9

i‘hmmeA

. secondi. Poi effettuiamo la chiamata a
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ElementTree cosi da poter analizzare
le informazioni contenute nel XML (se
vi perdete qui, per favore rileggete i

di FCM)). Poi chiudiamo il socket e
inizializziamo il contatore per il
numero di coincidenze trovate e
vuota.

Ora procederemo per passi

che vogliamo. Ricordate che le
informazioni restituite sono piuttosto

somiglianti a quanto mostratoin altoa :

destra.

Andremo in ogni gruppo di
informazioni per il genitore 'show'
analizzando le informazioni. In pratica,
tutto quello di cui abbiamo realmente
bisogno & il nome della trasmissione

mostrato in basso a sinistra, ma
gestiremo tutti i risultati.

Discutero il primo e voi capirete i
rimanenti. Mano a mano che

procederemo nelle informazioni,
miei articoli sull'’XML (parte 10,11e12 :
che sono apparsi nei numeri 36,37,e 38

cercheremo i tag (in basso a sinistra)
che coincidono con quelli voluti. Se ne

¢ troviamo qualcuno, gli assegniamo
una variabile temporaneae la

. mettiamo dentro al dizionario come
ripristiniamo la lista showlist a una lista

valore con chiave corrisponde a cio che :

. stiamo inserendo. Nel caso visto sopra,
. stiamo cercando il tag 'showid' nei dati
© XML. Quando lo troviamo, lo :
attraverso le informazioni XML usando :
il tag 'show' come genitore per quello

© questa trasmissione ha quattro

: differenti generi in cui puo essere
catalogata. Azione, Crimine,

: Drammatico e Fantascienza.
(<showname>) e lo showid (<showid>)

Dobbiamo gestire ciascuno di essi.

Infine, incrementiamo la variabile

foundcounter e aggiungiamo questo

for node in tree.findall('show') :

showinfo = []

genrestring = None

dict = {}
for n in node:
if n.tag ==

showid =
dict['ID']

'showid':
n.text

= showid

Full circle magazine #69 @ 10

<Results>
<show>

<showid>30789</showid>
<name>Continuum</name>

<link>http://www.tvrage.com/Continuum</link>

<country>CA</country>
<started>2012</started>
<ended>0</ended>
<seasons>2</seasons>

<status>Returning Series</status>
<classification>Scripted</classification>

<genres>
<genre>Action</genre>
<genre>Crime</genre>
<genre>Drama</genre>
<genre>Sci-Fi</genre>

assegniamo come valore alla chiave </genres>
'ID' del dizionario. </show>
) ) </Results>
La porzione successiva (nella

prossima pagina in alto a destra) ha a
. che fare conil genere della : elif n.tag == 'name’:
: trasmissione. Come potete vedere dal : ClEEEIED) B ol e
: . ; . : dict['Name'] = showname
. pezzettino di codice XML sopra, elif n.tag == 'link':

showlink = n.text
dict['Link'] = showlink
elif n.tag == 'country':
showcountry = n.text
dict['Country'] = showcountry
elif n.tag == 'started':
showstarted = n.text
dict['Started'] = showstarted
elif n.tag == 'ended':
showended = n.text
dict['Ended'] = showended
elif n.tag == 'seasons':
showseasons = n.text
dict['Seasons'] = showseasons
elif n.tag == 'status':
showstatus = n.text
dict['Status'] = showstatus
elif n.tag == 'classification':
showclassification = n.text

dict['Classification'] = showclassification

f'nwmeA
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dizionario nella lista 'showlist'. Quindi

i cciamo il dimento fi h Per oggi, inizieremo appena la elif n.tag == 'genres':
riraccamo [t procedimentofino ach€ = o tine (in a mezzo a destra) e la : for subelement in n:
non ci sono ulteriori dati XML. Una : if subelement.tag == 'genre':

: continueremo la prossima volta.

N PR i = o
volta che tutto é fatto, restituiamo la 3 S‘:‘lf’elementét‘?"t o §°ne;
lista dei dizionari (in basso a destra). . : e s
IS . La prossima volta aggiungeremo le : elsegenrestr:.ng = subelement.text
La maggior parte del codice & auto . altre routine. Per adesso il codice puo _ genrestring += " | " + subelement.text
licativo. Ci Leicl : essere trovato presso : dict['Genres'] = genrestring
esp |C§F|vo. I concentreremo sul ciclo . http://pastebin.com/6iwSNQrw :
for, utilizzato per stampare le :
informazioni. Eassmmo C|cl|came:nte : Arrivederci a presto. . def main():
attraverso ogni elemento dellalista : ;r = TvRage ()
del'dlz.lonarlestamplamo una 5 : # Find Series by name
variabile contatore, il nome della : : #
trasmissione (c['Name']) e l'id. Il : b : nam = raw_input ("Enter Series Name -> ")
isultat iali . |E| if nam !'= None:
risultato assomiglia a questo ... ; 3 o : sl = tr.FindIdByName (nam)
. GregWalters éil proprietario della : which = tr.DisplayShowResult (sl)
Enter Series Name -> continuum @  RainyDay Solutions, LLC, una societa di : if which == 0:
2 Found : consulenzain Aurora, Colorado e : sys.exit ()
:  programmadal 1972. Ama la cucing, le : else:
1 - Continuum - 30789 © escursioni, la musica e passare il tempo : option = int (which)-1
2 — Continuum (Web series) - !  conlasuafamiglia. llsuo sitoweb é : id = sl[option]['ID'] _
32083 © www.thedesignatedgeek.net. : print "ShowID selected was %s" % id

Enter Selection or 0 to exit —>:

Per favore ricordate che la lista ha foundcounter += 1

come base lo zero, cosi quando self.showlist.append (dict)
['utente inserisce '1' sta in realta . return self.showlist
chiedendo il dizionario numero 0. :
Facciamo questo perche ¢ Laprossima cosa che faremo sara creare la routine che mostra tutti i nostri risultati.
'normalmente’ la gente pensa cheil
conteqgio partada'1' e nondazero.E : def DisplayShowResult (self, ShowListDict):

. .gg D . : lcnt = len (ShowListDict)
quindi possiamo usare 0 per uscire : print “&d Found? % lent
dalla routine, evitando che usino'Q'o print " "
'q'0'-1' : cntr = 1

) for ¢ in ShowListDict:
: print "%d - %s - %s" % (cntr,c['Name'],c['ID'])
Ora la routine Main che collegail cntr += 1

sel = raw_input ("Enter Selection or 0 to exit -> ")

tutto per nol. return sel
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Scritto da Elmer Perry

e avete seqguito tutta questa serie

di LibreOffice Base, ora avete un

database con tabelle e relazioni. Siete
in grado diinserire le informazioni nel :

database attraverso i formulari, ma

che dire del prelevamento dei dati dal

database? Le query (interrogazioni,
N.d.T.) e i Report (presentazioni,
N.d.T.) sono utilizzati per estrarre i
dati dal proprio database. Le Query
determinano quali dati sono estratti

mentre i Report definiscono l'aspetto

dei dati estratti. Creeremo una query :
. anno di pubblicazione, autore(i) e

: tipo.

e un report per mostrare come
potete generare una presentazione
dei vostri dati.

Creare una Query

Le query ricercano determinate
informazioni nel vostro database. Si
possono creare in tre diversi modi:
con la procedura guidata, con la vista
struttura o con la vista SQL. La

tipo di relazioni create nel nostro
database e la vista SQL va oltre gli
scopi di questa guida, per cui

la nostra query. Ne verra creata una
che comprendera tutti i campi
importanti delle nostre tabelle: titolo,

Database e poi su Crea query in vista

© struttura nel pannello Attivita. Verra

: visualizzato il modulario Query

: Design e apparira la finestra di

. dialogo Aggiungi tabella o query.

: Aggiungete dalla finestra tutte le

: tabelle e quindi chiudetela. Ci si

) ) .. : ritrovera con il fFormulario che

procedura guidata non funziona conil : L '
: assomiglia un po' alle tabelle delle

. relazioni create in precedenza. Sotto :

. alle tabelle é visibile un modulario che :

X © andra a contenere i campi che si :

useremo la vista struttura per creare : .
: vorranno includere nella query.

: Trascinare nel formulario, dalla

LibreOffice Parte 22: Query e Report con Base

B\ -

. creare la query é possibile fare clic

. con il tasto destro sulla nuova query
. creata e selezionare Modifica in vista
: SQL. Apparira la finestra Query

. Design con la sintassi SQL completa

"|: della query appena creata.

=1 Authors ™ Books ™ Booksauthors | T BooksMedia & ™ Media
] .;-uthDHLJ YV .EDDEIIJ ¥ ;l:ll:IkIIJ ¥ -EI-B-EII'.ILJ ¥ ;1E'E|~'J}U
Kame Title ¥ AuthoriD ¥ MedaiD Type
Pubkshed ‘
Fheid Type Tithe Published Nama .
hlias
Table Madia Books Books Authors
Sort
Wisible =
¢ ((Function

Fate clic su Ricerche nel pannello

tabella Libri, i campi Titolo e

: Pubblicato e dalla tabella Media, i
: campi Nome e Autore. Questo é tutto :
: ¢id che occorre per questa query.
© Salvarla come 'TuttilCampi'. Chiudete :
- il Formulario Query Design.

Avete ora una query da utilizzare

. Raccomando di non modificarla senza
. le necessarie conoscenze su SQL, ma

: puo essere di aiuto, per chista

- imparando il linguaggio SQL, creare

© piu query in Vista struttura per poi

: visualizzarle in Vista SQL.

. Creare un Report

Un report esegue una query e ne

. formatta il risultato in un qualcosa di
: utilizzabile. Si possono creare molti
. differenti report con le query create a

: ] ) o : seconda di come si raggruppano i dati
. per la creazione di report multipli per : g9rupp

- il nostro database. Se siete curiosi di
: conoscere la sintassi SQL usata per

- dalla query. Creeremo un report per
- ordinare i nostri libri per tipo di media
: e visuggerird come potrete crearne

Steps
Tables or guesies
2. Labsling ficlds |Query: allFields
3. Groupi :
HUETD Available fiekds
4, Sorl oplions

5. Choose layout
6. Creats report

Which fields do you want to have in your report?

Ereleds in report
Type

Title

Puklished
Maime

"
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altri usando la stessa query.

C'@ un solo modo per creare un
report, la procedura guidata.
Selezionate Rapporti nel pannello

Si puo davvero vedere il vostro
modello riempirsi man mano che si
avanza nei passaggi della procedura
guidata, fornendovi alcune idee su
come apparira il vostro report finale.

Nel passo 1, sceglierete la query e

i campi da usare nel report. Se non &
gia selezionata, scegliete la query
"TuttilCampi', appena creata.
Spostate tutti i campi nel riquadro
Campi del rapporto premendo il
pulsante >>. Se volete creare un
report che usa solo alcuni dei campi
dovrete selezionare solo quelli
necessari. Per il nostro report
utilizzeremo tutti i campi. Fate clic su
Avanti.

Il passo 2 e 'etichettatura dei
campi. Qui specifichiamo l'etichetta

. che avranno i campi nel report.

: Cambiare la didascalia di Tipo in Tipo
. di media e di Nome in Autore(i).
Database e fate clic su Usa procedura :
guidata per la creazione dei rapporti... :

la data di pubblicazione verra ripetuta
nel modello del report, un effetto

. collaterale che non vogliamo.
. Escludiamo il campo Nome perché se :
- ci fosse piu di un autore, li vorremmo

e,

stops Hewe de you want to ksbel the Falde]
1. Fleki wbaction %] Lahwd

Tipd MRS Type
3. Lfnegiieg
4, St optons Tk THli
4, Chache layout Pubirsipd Pk e
6. Create report

Mama |

Nel passo 3 creiamo i

© raggruppamenti. | raggruppamenti

. controllano come sono combinati e

. ordinati i campi nel report. Sono

. importanti perché possiamo usarli

: per creare un report completamente
. diverso a seconda di come

© raggruppiamo i campi. Per esempio,

. sevolete creare un report di titoli per :
: autore dovrete mettere come primo
: raggruppamento il campo Nome,

- quindiil campo Titolo come

. sottogruppo. Per il nostro report

: stiamo per creare un report di Titoli

. per Tipo di media quindi l'ordine di

© raggruppamento é Tipo, Titolo e

" Pubblicato. Aggiungiamo Pubblicato

in quanto, se ci fosse piu di un autore,

Premete Avanti. . elencati insieme. Premete Avanti.
D (el e N
Eiaps Do yéu mant 1o add grooping levels? Eiems Aicording ke which figlds da you want]
s Pkt Uull:.?;mn-\- - ::; s Sort by
ok ok Syreaat 3 droupng
¥ T -Ir-m uT
C Sl i Chogee leysst
S
Than iy
Fiots. The Sussimy el wit Se riglecsd bry dids firm | Thaat by
rwzort o cretecd
Hep w B et =

L'ordinamento viene effettuato

. nel passaggio 4 ma non abbiamo

. molto da fare qui. Noterete che &

. possibile cambiare soltanto

. |'ordinamento crescente o

. decrescente del raggruppamento.

. Selezionate Nome nel quarto

: contenitore e lasciarlo su Crescente.

. Premete Avanti.
o e
Eiaps Fany o i mEad your ropart Bo lakT

Lansacspe
oty Al
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Nel passo 5 possiamo scegliere la

. disposizione dei dati e l'intestazione.
. Ci sono molte combinazioni che

: cambiano l'aspetto del report. lo

. lascio quella predefinita ma sentitevi
. liberi di giocare con tali opzioni. Sotto
- al riquadro Layout dei dati si puod

. selezionare sia l'orientamento

. orizzontale che verticale. Per questo

. report credo che quello verticale sia

. pill appropriato. Premete Avanti.

nb
.i_l_uu. Decide how you want to procesd
1. Fiekd st tmn Thike ol iepart
2. Labeing By T Typg

Gricging
g Wat kind of repeT di yoa sant 10 crsl

STalle e

[ynamic repor
i B el Wi P e el e

4, Sort ot

&, Chagas lepaut

ModEy repoet layout
Create repoit niow

Nel passo finale si crea il report.

. Potete assegnargli un titolo, indicare
© come verra usato e che cosa i si

: vuole fare. A questo report diamo

. come titolo 'TitoloPerTipo'. Ora si

. . deve rispondere a due domande. Che
e raoms | tipo di report volete creare? Un

. report statico si usa una sola volta.

. Non si pud cambiare. Una volta

.. | creato, i dati sono Ffissati. Se tuttavia,

. volete un report riutilizzabile, vi serve

Teprawed by | .
when e

" esattamente un modello che si pud

un report dinamico, che e

h- indice ©
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utilizzare di nuovo. Questo report lo
vogliamo di tipo dinamico da poter

riusare, quindi selezioniamo Rapporto :

dinamico. Come volete procedere
una volta creato il rapporto?
Cambiare layout di pagina vi
permettera di editare il report come
se fosse un documento di writer.

creare con la nostra unica query.

La prossima volta useremo le

: macro per migliorare il nostro :
. database e farlo funzionare pit come :
. un'applicazione. :

Creare rapporto ora & owio; riempira :

i dati e generera il report. Possiamo
sempre cambiarne la disposizione

successivamente, quindi selezioniamo :

Crea rapporto ora. Premete Fine.

Base genera il nostro report e lo
visualizza in una finestra di Writer.

Tale report creato & in sola lettura. Se
volete modificarne il testo o l'aspetto
bisogna chiuderlo, fate quindi clic con

il tasto destro sul nostro report nel
pannello Rapporti e scegliere
Modifica. Si aprira nuovamente in
Writer, da dove ora si potranno

aggiungere testo, grafici, ecc., proprio

come si farebbe con un qualsiasi
documento Writer. Basta solo fare
attenzione quando si cambia
qualunque cosa si trovi nelle celle
dove sono collegati i dati.

In questa guida, abbiamo creato
una query e un report. Giocate con le

impostazioni di raggruppamento e di
ordinamento nella procedura guidata :

dei report e vedrete esattamente
quanti differenti report si possono

=

La storia lavorativa, di programmazione
e informatica di Elmer Perry include un
Apple IIE, con alcuni Amiga, un generoso
aiuto di DOS e Windows e una
spolverata di Unix, il tutto ben
mescolato con Linux e Ubuntu.
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16x16 SUDOKU

I numerida0a9 e le lettere da A a F devono essere inserite
all'interno della griglia 16x16 in modo che ogni riga, ogni
colonna, e ogni box 4x4 contenga unsolo0-9e A-F.

7/8| |6| |F| [2|D|B|9]| |A|3
6|F E 3|A IC|2
2 1|D A 8 | |5
931 6 4|E|D
Cl1 3 8 DIE| |4
B|A|4 E[3[9|5 F| |0
9 2/4| |C|6|A | |8
D 6|A|8|7 4 1]
9 5 0/6/3|B E
5 7/D|9| |B|E | [1
D| [B 3|C|5|9 8/6|F
0| [3]2 4 Al |97
A|7|B E 9/0[2] |
8 F 3 B|5 D
1|B 90 F 8|3
0/E| |2|4|C|6| |8| |5| |F|[B

Le soluzioni sono nella terz'ultima pagina.

| giochi sono copyright, e gentilmente Forniti da,
The Puzzle Club - www.thepuzzleclub.com
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Scritto da Marcel le Roux

Ubuntu in Stile Ghome 2

I o, come anche altri ex fan di
Ubuntu, mi sono spostato verso
Linux Mint per stare il pit lontano
possibile dal desktop Unity. Benché
all'inizio rimasi stupito di Mint, la mia
preoccupazione é stata il fatto che ci
siano troppe varianti desktop.
Vedendo che Mint si basa su Ubuntu,
ho deciso di dare un'altra occhiata a
questa distribuzione con la versione
12.04 LTS. Tuttavia non avevo
intenzione di restare con Unity, cosi

ho subito cercato il modo diinstallare :
! ppa:gnome3-team/gnome3

Gnome 3 e modificarlo in modo che
assomigli e funzioni come il tanto
amato Gnome 2. Non voglio
prendermi alcun merito per le

messo insieme al fine di raggiungere
il mio obiettivo. Visto che ha
funzionato, ho voluto soltanto
condividerlo con tutti gli altri. Quindi,
andiamo:

Dopo aver installato Ubuntu
12.04, avviate il vostro computer e
installate Gnome 3. Copiate e
incollate le seguenti righe nel
terminale (premete Ctrl-Alt T per

aprire una finestra del terminale), per : :
: /apps/metacity/general/button_ :

ottenere l'ultimo rilascio dal team di
Gnome:

leroux

Password

Guest Session

sudo add-apt-repository

sudo apt—get update

i sudo apt-get install gnome-—
= ; ! shell
soluzioni alternative che ho trovato e :

Riavviate il vostro computer e,

: quando appare la schermata del login, :
© fate clic sulla piccola icona di Ubuntu
: che si trova accanto al nome utente

: scegliendo 'opzione Gnome Classic.

Per riportare a destra i pulsanti

delle finestre (massimizza, riduci e
© chiudi) aprite nuovamente un
: terminale e copiate cio che segue:

gconftool -s

layout -t string
menu:minimize, maximize, close

‘ < Back ‘

&) cnoME

&) cnoME classic

@ GNOME Classic (No effects)

@ Ubuntu
() ubuntuzp

Probabilmente avete in mente di

. installare anche Gnome Tweak Tool,
. che vi permette di avere maggiore

- controllo sulle vostre estensioni della :
. shell e altre impostazioni Ghome. '

Advanced settings

. Potete installare questo programma
. direttamente dai repository di

. Ubuntu o digitando questo comando
: nel terminale:

sudo apt—get install gnome-
! tweak-tool

Potete trovare adesso lo

. strumento di personalizzazione

: cercando "Impostazioni avanzate" tra
. le vostre applicazioni o nel menu

: "Strumenti di sistema".

Se volete cambiare il tema,

. sbarazzarvi della overlay scrollbar e

fare molte altre personalizzazioni,
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Q

Have file manager handle the desktop m
Files ;

Computer iconvisible ondesktop m
Fonts
shell Home icon visible on desktop m
St Bt eniol Metwork Servers icon visible on the desktop OFF |
Theme
windows Trash icon visible on desktop on |

Show mounted volumes on the desktop |'oFF
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potete scaricare e installare questo
utile programma: http://ubuntu-
tweak.com. Una volta fatto, potrete

molto stabile.

Ubuntu Tweak D

(©)) ubuntu

trovare Ubuntu Tweak sotto il menu @ a
"Impostazioni di sistema Ubuntu".
Overview = Tweaks  Admins  Janitor Il Podcast Ubuntu copre tutte le
Infine, ma & solo una mia scelta ultime notizie e novita che si

personale, potete rimuovere il presentano agli utenti di Ubuntu
pannello superiore premendo alt + A ronts %, Miscellaneous i sound jll theme Linux e ai fan del software libero in
tasto destro del mouse e selezionare generale. La rassegna é rivolta tanto

"Rimuovi pannello”. Poi potete all'utente piu fresco quanto al
aggiungere il menu prlnCIpale/|n|Z|ale R e ety programmatore pill esperto. Le
['area di notifica, l'applet degli nostre discussioni riguardano lo
indicatori ecc. al pannello inferiore Bl ikt ions e sviluppo di Ubuntu ma non sono
premendo alt + destro del mousee  :| eccessivamente tecniche. Siamo
facendo clic su "Aggiungi al pannello”. : abbastanza fortunati da avere
Sono veramente contento del ; i File Manager Workarounds qualche gradito ospite nello show a

risultato finale e finora sembra essere :

passarci novita di prima mano sugli

ultimi eccitanti sviluppi a cui stanno

lavorando, in modo comprensibile a
tutti! Parliamo inoltre della comunita
Ubuntu e di cosa le interessa.

Lo show ¢ offerto dai membiri della
comunita Ubuntu Linux del Regno
Unito. Essendo coperto dal Codice di
condotta di Ubuntu, & adatto a tutti.

Lo show e trasmesso live ogni due
settimane il martedi sera (ora
inglese) ed e disponibile per il
download il giomo seguente.

podcast.ubuntu-uk.org

= leroux -

B & o 19 r

[Update Manager]

Cu@E€ I3
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( : ome promesso lo scorso mese, 0ggi :
inizieremo a creare qualcosa. Ma
prima di tutto, distruggiamo il cubo!

Scritto da Nicholas Kopakakis

tridimensionale in due dimensioni

modellazione!

Iniziate un nuovo progettoin
Blender: File > New, o aprite
semplicemente Blender.

Nell'immagine in basso a sinistra

abbiamo quindi una vista ortogonale. Il

: nostro cervello non puo capire quale

Premete ['1 del tastierino numerico
per avere una vista frontale. Nell'angolo :
in alto a sinistra potete accertarvi di cosa :
state visualizzando.

noi non interessa propriamente la

: prospettiva, quanto le dimensioni

. effettive del nostro modello. La

Adesso premete il tasto 5, sempre
del tastierino. Potete cosi cambiare la
vista da “Prospettiva” a “Ortogonale”.
Premendo il tasto 5 infatti si passa dalla
vista in prospettiva a quella ortogonale

e viceversa.

: prospettiva sara molto pil realistica se
. creeremo modelli senza tener conto di
: essal

Nell'immagine in basso a destra,

. vediamo il cubo in maniera prospettica;

in questo modo il nostro cervello

Suggerimento: La modalita Prospettiva :
e la stessa di come i nostri occhivedono :
il mondo. Gli oggetti piu vicini sembrano :
pit grandi di quelli distanti. :

Con la vista Ortogonale, d'altra
parte, &€ come guardare un oggetto da
una distanza infinita. Tutti gli oggetti
sembrano essere alla stessa distanza
rispetto agli occhi. La proiezione
Ortogonale € uno dei modi per
rappresentare un oggetto

comprende qual & il lato piu vicino,
(http://it.wikipedia.org/wiki/Proiezione_
. ortogonale), molto utile per la :

sapendo che si tratta di un cubo.

Owviamente questa € una mia

© opinione. Pud darsi pure che voi riusciate
: amodellare meglio e pitl rapidamente
: usando la vista in prospettiva. Tutto

. dipende dalle vostre capacita.

: lato sia quello frontale. Ma & molto utile

: per creare modelli, dato che difattoa

Pochi mesi addietro, Mark ha

© cominciato a spiegare il grande
: programma Inkscape (in futuro _
: vedremo come combinare Inkscape con
: Blender) creando un pupazzo dineve. M :
: & molto piaciuto quell'esempio, quindi
:anche noi creeremo un pupazzo di neve.
© Ma prima, distruggiamo il cubo! :

Selezionate il cubo conilTDM e

: premete il tasto X o Canc, confermando
' : vostro schermo. Niente paura, TSM e

. trascinate la freccetta blu che punta

: verso l'alto, per muovere la sfera lungo
. l'asse delle Z. Piazzatela vicino alla

- sommita della sfera che é rimasta fissa.
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poi l'eliminazione conil tasto Invio.

Adesso premete Shift+A per

aggiungere qualcosa e dal menu

selezionate Mesh -> UV Sphere o

. dall'intestazione premete Add -> Mesh
. ->UV Sphere per aggiungere un nuovo
: reticolo alla scena. Ecco che appare una
. sfera.

Immagino che vi troviate in una vista

- ortogonale-frontale (quardate

nell'angolo in alto a sinistra della vostra
finestra di vista 3D), con la sfera

. selezionata. Se non fosse cosi, premete

1 dal tastierino numerico.

Premete Shift+A per aggiungere un

. nuovo reticolo, di nuovo una sfera UV.

Non vedrete nessuna differenza sul

Premete il tasto S per scalare la sfera

. muovendo il mouse verso il centro del

: cursore. Traslate ancora un po' la sfera

- versoil basso in modo che un pezzettino
. sia“nella” sfera pit grande.
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Adesso premete Shift+D per

duplicare la sfera selezionata. Premete Z -

per bloccarne il movimento alla sola
asse Z, poi premete e tenete premutoil
TSM per muoverla vicino alla sommita
della seconda sfera.

Premete S e scalate la terza sfera.

E gia qualcosa.

Premete File -> Save As per salvare il

vostro lavoro. Selezionate dove volete
salvare il file, dategli un nome univoco
(pupazzodineve.blend, ad esempio) e

premete il pulsante Save As Blender File

nell'angolo in alto a destra. Fantastico!

Ora, selezionate la prima sfera
premendoci sopra con il TDM. Premete
Se quindiZ per scalare la sfera solo
relativamente all'asse Z.

Fate lo stesso per le altre due sfere
in modo da renderle piu “realistiche”
(come mostrato al centro, a sinistra). La
gravita schiaccia le palle di neve verso
terra.

Premete N per aprire o chiudere il
Transform Properties shelf sulla destra

della vista 3D. Da qui, potrete visionare e

modificare le proprieta del vostro
oggetto numericamente (come
mostrato al centro, sulla destra).

Nella vista ortogonale frontale,

. premete TSMin qualunque punto a

. destra del corpo del pupazzo di neve.

. Premete Shift+A per aggiungere Mesh
. ->Cone. Premete R per ruotarlo, e 90

- perindicare ['angolo di rotazione.

. Suggerimento: Potete inserire :
- manualmente dei valori semplicemente :
. digitandone il valore. Potete anche '
© usare valori negativi per ruotare gli
© oggettiin senso antiorario.

Premete il 3 del tastierino numerico

. peravere la vista da destra. Premete S
. per scalare e Shift+X per vincolare la
" dimensione lungo ['asse delle X e

modificare in contemporanea quelle su

: YeZ. Scalateil cono in modo da dargli

: una dimensione simile ad una carota,

: relativamente alla terza sfera creata (la
" testa del pupazzo).
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OK, ora premete 1 per la vista

. frontale, quindiS e X per apportare

. modifiche solo relativamente all'asse X.
: Ora create un naso a carota lungo o

. corto.

Premete R e-10 per ruotare il naso di

: 10°in senso antiorario.

Usando la vista frontale e quellada

destra, piazzate il naso da qualche parte
: al centro della testa del pupazzo.

Ora creiamo qualche bottone.

Premete Shift+A per aggiungere Mesh

: ->Cylinder. Usate lo stesso strumento

. usato per modellare il naso-carota per

. creare un bottone delle dimensioni di
:una moneta. Scalatelo, ruotatelo, usate

. lavostraimmaginazione! Non

. dimenticate poi di duplicarlo con Shift+D
. per essere piu produttivi.

Quando sarete soddisfatti del vostro

. modello, salvate il vostro lavoro.

Premete F12 per farne un rendering.

Il pupazzo di neve sembrera un

. tantino ridicolo. La neve non ha quei
. bordi, sembrano piu dei cristalli ben
- realizzati! Dobbiamo smussarli un po'.

Quindi, premete il tasto T per aprire

* il Tool Shelf e gli strumenti adatti sulla
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sinistra. Sotto la sezione Shading, avete
due opzioni: Smooth e Flat. Con una
sfera selezionata (o anche tutte)
premete il tasto Smooth. Il vostro
pupazzo di neve sara ora piu liscio!

Potete osservare la differenza.
Nell'immagine al centro sulla destra, le
sfere sono livellate come se fossero dei
cristalli, mentre in quella sulla sinistra
abbiamo applicato lo Smooth che
conferisce levigatezza e naturalita alla
neve.

Usando lo strumento di selezione
Riguadro che abbiamo visto il mese
scorso, selezionate tutti gli oggetti che,
uniti, rappresentano il “pupazzo di
neve”. Le sfere, i cilindri e il cono.

Usando la freccia blu, muovete il
pupazzo di neve verso l'alto come
mostrato nelle immagini qui sopra,
giusto un pelino sotto 'asse rosso.

Premete Shift+S. Dal menu Snap
apparso, selezionate Cursor to Center.
Premete il tasto 7 del tastierino
numerico per la vista dall'alto. Premete
Shift+A per aggiungere un nuovo

lemento. Un P! ianc). P .
elemento. Un Plane (un piano). Premete . interessante per Blender. Per questo

: mese, vi consiglio caldamente
. http;//www.Blendernation.com, un sito
¢ molto utile con notizie fresche riguardo

Sperscalareil piano e 10 per scalarlo di
10 volte.

Abbiamo un terreno.

Salvate il vostro lavoro con un nome
© univoco.

Renderizzate il pupazzo di neve

. premendo F12.

Se la vostra videocamera non

. riprende il modello come desiderate voi,
: spostatela. .

Ogni mese, vi suggeriro un sito

Blender.

E anche per questo numero ho un
: video per voi. Andate su :
. http://www.youtube.com/watch?v=TLk :
: AORELQ1g, e gustatevi “Elephant :
© Dreams”, un corto d'animazione creato :
: con Blender nel 2006 dall'Orange Open
© Movie Project. :

Il prossimo mese, aggiungeremo un

: cappello, una pipa probabilmente e delle
© mani simili a scopette. Inoltre, vi :
© introdurro I'Edit Mode (la modalita

: modifica), il luogo in cui andrete a

: spendere la maggior parte del vostro
: tempoin Blender!
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calk
a=)
Nicholas vive e lavora in Grecia.
Lavora per una casa di post-
produzione (pubblicita-film) da
diversi anni. Tre mesi fa € migrato su
Ubuntu perché “renderizza piu

velocemente”. Blender ha trovato lui
due anni fa.
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Scritto da Mark Crutch

Inkscape - Parte 9

J

Avendo trattato 'uso dei gruppiin
Inkscape, ci sposteremo adesso

sui 'livelli' — che sono proprio come i
gruppi ma con un'interfaccia diversa

per manipolarli. Vi & una buona ragione :

per le similarita tra gruppi e livelli: il
formato SVG non ha un concetto di
livelli cosi Inkscape, di fatto,
implementa ciascun livello come un
gruppo con alcune parti extra di dati
personalizzati.

© finestra dedicata Layers e alcuni
© strumenti ad accesso rapido nella barra :
. distatoin fondo alla schermata. :
© Cominciamo con la sotto finestra
Layers che pud essere aperta tramite la :
. voce di menu Layer>Layers, premendo
© CTRL-MAIUSC-L o utilizzando il

© pulsante View Layers sulla
© barra degli strumenti.

=

La finestra livelli @ abbastanza

|.ﬁl & Layer

Blend mode: ‘Nurmat &
|

Opacity: -'|:I|1t]t].0 1|

Visono tre parti dell'interfaccia di
Inkscape che vengono utilizzate per
gestire i livelli: il menu Layer, una sotto

= | Layer name: |Layer 2|

L8

Posltion: | Above current

Cancel | Add

livello.

Visono parecchi modi di creare un

: nuovo livello ma il pit owio &

semplicemente fare clic sul pulsante

: verde +in fondo alla finestra Layers. Vi

- sara suggerito di dare un nome al livello :

: e discegliere una posizione per esso.

© Per adesso chiamiamo il nostro nuovo :

: livello "Layer 2" e posizioniamolo sopra

: : il livello attuale.
© scarsa, consistendo di un elenco di livelli :

2 ¢ in cima e di alcuni pulsanti e altri widget :

: al fondo. Per un nuovo file sara

| i presente solo un singolo livello,

| © chiamato di solito "Layer 1". Create

: alcuni oggetti nel vostro disegno ed

: essi diverranno parte di quel livello.

: Adesso provate a fare clic sulla piccola

© jcona, l'occhio a sinistra del "Layer 1" e

© viaccorgerete che i vostri oggetti

© svaniscono. Fate di nuovo clicsu diessa :

© e riappariranno. Fate clic sull'icona della :

© catena e vi verra impedito di fare

: qualunque cambiamento agli oggetti

: nellivello. Un secondo clic sbloccherail

La finestra Layers dovrebbe

"Layer 2" sia selezionato e disegnate
degli altri oggetti assicurandovi che si

livelli, il che a sua volta altera lo z-index
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- degli oggetti nel vostro disegno.

. Ricorderete che i contenuti dei gruppi
© non possono essere interfogliati, con
: ciascun gruppo che occupa un singolo
. "slot" nello z-index. La stessa cosa si

. applica ai livelli: potete spostarli 'uno

rispetto a un altro ma i loro contenuti

© non si possono mescolare.

Quando create un nuovo livello

potete usare il pop-up Position per

. scegliere se il nuovo livello deve stare
. sopraosottoillivello attuale. Vié

: apparire proprio come vi aspettate, con
: duevoci: "Layer 2" & in cima all'elenco e
© "Layer 1" & sotto di esso. L'ordine dei
: livelli nella finestra rappresentail loro z- :
© index all'interno del disegno cosicché i
: livelli piu in basso nell'elenco

: appariranno indietro ai livelli che sono
: piuin alto nell'elenco. Controllate che

anche una terza opzione, quella di
renderlo un sub livello dell'attuale

. livello. I'sub livelli appaiono nella

finestra sotto il loro livello genitore,

leggermente indentati. Il genitore

© acquista una piccola icona a triangolo
. che pud essere usata per mostrare o
. nascondere ['elenco dei sotto livelli.

. Allo stesso modo dei gruppi che

: possono essere profondamente

© sovrappongano agli oggetti precedenti
: del"Layer 1" e che sianoin un colore
adeguatamente contrastante.

iy s : Dovreste essere in grado di vedere che
: ] © jvostri nuovi oggetti vengono sempre
. disegnati sopra i vecchi oggetti. _
© Utilizzando le icone freccia in fondo alla
- finestra Layers potete riordinare i vostri :
' " usando il pulsante a triangolo:

annidati, cosi & possibile aggiungere

. sublivelli ai sub livelli— sebbene andare
. afondo didue otre livelli & possibile

che, piu che aiutare, confonda.

: Quest'immagine mostra il nostro
¢ "Layer 1" con l'aggiunta di tre sub livelli,

due dei quali hanno anche loro dei sub
livelli, uno dei quali € compresso
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" Layers (SHiferCErls = o /x|

Sl ayers (Shift+Cerl+L) =
E# & Layer2
|4 @ ¥ Layer1
% @ P Layer1.3
% @& + Layer1.2
@ Layer1.2.1
@ o Layer 1.1
w - vy =
Blend mode: | Normal < |

Opacity:

L'ordine dei sub livelli all'interno
della finestra segue le stesse regole
come peri livelli normali: pit in basso &
il sub livello nella finestra, piu in basso
saranno nel disegno i suoi contenuti
nello z-index. Da cio ne segue cheiil
contenuto di un sub livello apparira

sempre sotto qualunque contenuto nel

suo livello genitore. Sebbene cid abbia
un senso logico, spesso non é cio che
desiderate da un punto di vista
artistico, cosi trovo che il migliore
approccio nell'usare i sub livelli sia
semplicemente mantenere vuoto da

oggetti il livello genitore e costruire un

sub livello aggiuntivo sotto gli altri per

tenere qualunque contenuto di sfondo.

Ilvantaggio piu grosso dei sub livelli
. @ quello di nascondere subito parecchie :
. parti di unaimmagine con rapidita.

[100.0 [¢f||:

% @ v Snowman
& & Hat
o Arms

% & Head

W G Body

% & Background

sub livello o di nascondere o bloccare
rapidamente l'intero personaggio

: usando le icone per mezzo del livello
Considerando il nostro pupazzo dineve :
. delle puntate precedenti, potreste
. facilmente costruire un livello genitore
. per contenere il pupazzo di neve come
: unintero, con parecchi sub-livelli per

. ciascuna parte del suo corpo. Adesso

. avete la capacita di nascondere o

. bloccare le sue parti individuali

. utilizzando le icone accanto a ciascun

genitore.

Ricorderete che la puntata

. precedente suggeriva di raggruppare
. insieme le varie parti del pupazzo di
. neve per creare un singolo oggetto che :
. potete muovere intorno con facilita.
- Allora cosa & meglio, il raggruppare o
. usarei livelli? Come & spessoiil caso, la

Al Lst P Hegpaeai's QluididEch bagen
faced some sarious compatition

Snma rights resoresd Vﬁuﬂlt-‘iir
- Ry MG EA
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risposta e “dipende”. Per qualcosa
come il pupazzo di neve tenderei ad

. utilizzare i gruppi: la capacita di

. spostare l'intero personaggio come una
. cosa sola & di solito piu utile della

. capacita nasconderlo. Per lo sfondo

. dellimmagine (la neve, il cielo, le stelle)
. probabilmente userei un livello: &

. improbabile che spostiate molto lo

. sfondo ma potreste volerlo

. nascondere, quando lavorate sul

. pupazzo di neve, o bloccarlo per evitare
. che, accidentalmente, venga

. modificato una volta che ne siete

. contenti.

Guardiamo ad un esempio del

. mondo reale (mostrato sotto). Questa
. @ unastriscia di fumetto che ho

disegnato nel 2010, insieme alla

. corrispondente finestra Layers. Potete
. scaricare il file sorgente di Inkscape
. dallURL alla fine dell'articolo.

Lavorando dal livello in cima verso il

. basso, dapprima abbiamo un livello

. Frame che & bloccato. Questo & un

. bordo nero spesso che sta come livello
. pit alto in molti dei miei fumetti e

. nasconde le estremita delle linee che si
. estendono fuori dallimmagine

. principale, cosicché non devo stare cosi
. attento quando disegno oggetti vicino
. ai bordi della scena. Dopo vi € il livello

. testo che contiene sia la didascalia per

questo fumetto sia la casella in cui essa
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sta. Anche quel livello e bloccato per
evitare che possa spostarlo

accidentalmente quando modifico altre
parti del fumetto. :

el A

lavers (Shift+Ctri+L)
& Frame

@ Text

® v Content

G} Speeder
Rings
Towers

B

Background

& E E E & E E E

B B B

Border

‘ L ) v =

ey

Blend mode: | Normal #

{L1]]100.0 v;

Opacity:

questi sub-livelli gli oggetti sono
raggruppati, cosicché il livello Towers
contiene tre gruppi, UNo per ciascun

. livello. Cio mi ha consentito di spostare
. © ciascuna torre individualmente,
i : sebbene ancora mi dia l'opzione di
: nasconderli all'istante.

Questi ultimi due livellisono

. particolarmente interessanti perché

© entrambi contengono oggetti

. pesantemente sfumati. Le sfumature
J© sonoimplementate come filtri SVG, che :

: saranno trattati in un articolo futuro,

Sotto quello c'¢ il livello Content. In
molti dei miei fumetti questo viene
usato come un livello normale a sé
stante, con tutti i personaggi principali
e gli oggetti che vengono piazzati
direttamente entro di esso. In questo
caso, volevo essere in grado di
nascondere varie parti del disegno
mentre stavo lavorando su di esso, cosi
il livello Content & solo un contenitore
per vari sub-livelli. Dentro ciascuno di

: ma a questo stadio ¢ utile sapere chei
. filtri possono essere matematicamente
: intensivi e possono rallentare

. significativamente la velocita di

- rendering di Inkscape. Uno dei modi
. migliori di evitare questo rallentamento :
. @ nascondere il livello che contiene gli
: oggetti filtrati. Inkscape non deve

. disegnarli, cosi non fa le operazioni

" matematiche richieste e pud

rappresentare la vostraimmagine

molto piu rapidamente.

Quando disegnate un'immagine

. complessa, potreste scoprire che

. dovete spostare gli oggetti trai livelli.
: Cid non pud essere fatto dalla finestra
. livelli ma & gestito, invece, dal menu

: Layer o da una scorciatoia da tastiera.
: Il livello Backgrounds contiene tutto :
. il resto che é visibile all'interno

. dell'immagine del fumetto, inclusi le

. pareti dell'arena e l'orizzonte collinare.
- ILlivello Border, ancora una volta

: bloccato, contiene un bordo comune

. che utilizzo coi miei fumetti che

. contiene informazioni sulla licenza,

- ['URL del mio sito web e un'ombra

: proiettata.

Selezionate gli oggetti che volete

Un'altra opzione che vedrete nel

. menu Layer & Duplicate Current Layer.

: Questa, non soltanto duplicaiil livello

. stesso ma anche tutti gli oggetti dentro
il livello, incluso qualunque sub livello e :
© suoi contenuti. Poiché gli oggetti :
. duplicati appaiono direttamente in

© cima agli originali, non & sempre owvio
. che siano state create delle copie, cosi

siate un po' attenti quando usate

questa opzione. Potete anche ;
. duplicarei livelli direttamente dentro la :

finestra Layers utilizzando il menu

contestuale sul nome del livello.
Sebbene il menu contestuale offra
. un'opzione “Rename Layer...", disolito

e piu facile fare clic sulnome diun

Una strana omissione dal menu
contestuale e ['opzione per eliminare
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un livello. Questa e disponibile tramite
la voce di menu Layer>Delete Current

. Layer o dal pulsante rosso meno nella

. finestra. Attenti che questo cancellerail
- livello e tutto all'interno di esso, incluso
. i sub-livelli, senza nessun ulteriore

. suggerimento. Se eliminate

. inawvertitamente un livello dopo non

. tuttoé perduto, dato che Edit>Undo
spostare e usate Layer>Move Selection
. to layer Above (MAIUSC+ PaginaSu)o
. Layer>Move Selection to Layer Below
: (MAIUSC+ PaginaGit).

(CTRL+Z) lo ripristinera.

Terminiamo il nostro tour della

finestra Layers coni controlli al fondo. Il
. regolatore Opacity funziona alla stessa
. maniera di quello nella finestra Fill and

. Stroke ma si applica a tutti gli oggetti

. nel livello selezionato. E ancora un altro
. dei molti modi di Inkscape di rendere

invisibili gli oggetti.

Il pop-up Blend Mode definisce

. come viene disegnato il livello

. selezionato rispetto ai livelli sotto di

. esso. Proprio come il regolatore Blur
. nella finestra Fill and Stroke, & di fatto

una scorciatoia per aggiungere un filtro.

. Le modalita di miscela offerte sono

. Normal, Multiply, Screen, Darken e
Lighten, sebbene raramente vi sia

. molta ragione di usare qualunque altra
. al di fuori di Normal. So di un artista che
- livello selezionato che si trasformain un :
. campo modificabile.

mette tutte le ombre delle sue

. immagini dentro un singolo livello che &
. impostato a Multiply e ho anche usato
- la modalita Multiple per produrre una

immagine anaglifo in 3D dello space
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HOWTO - INKSCAPE Parte 9

shuttle. In questa immagine ho usato essere scaricati da:
quell'anaglifo space shuttle per http://www.peppertop.com/fc/
dimostrare le differenze tra le modalita : :

di miscela ma l'effetto reale prodotto
dipende altamente dai colori con cui
cominciate.

Vi & rimasto un solo aspetto da :
menzionare della gestione del livello :il :

menu pop-up sulla barra di stato. @
Questo vi consente di cambiare .
rapidamente trai livelli e di nascondere, : Normal Multi ply Screen

mostrare, bloccare o sbloccareiil livello  :
attuale utilizzando i pulsanti alla sinistra :
del pop-up. :

W & | “Shuttle Multiply 2

La puntata precedente ha :
presentato questo pop-up nel contesto

della gestione dei gruppi. Questo & un ®
effetto collaterale del fatto cheilivelli : .
sono solo dei gruppi con un po'dimeta Darken nghtE n

dati extra. In questo caso il nome sul

pulsante sarain effetti lID internodel  : _ ragione tendo a usare soltanto |
gruppo e potete usare il menu per . W o | *#g3273 < | . pulsanti Hide e Lock nella finestra
uscire da un gruppo cambiando a un - Layers o almeno, prima di usarli dalla

gruppo genitore o dl-rettamep‘te aun . Attenti, comunque, che usare i barra di stato, controllo due volte di )

livello interamente dlversq. Cio puo . pulsanti Hide o Lock quando avete . non essere dentro un gruppo. ! E

essere part|colarme{\tedutlle Sevi . selezionato un gruppo pud essere : : Mark utilizza Linux dal 1994 e usa
trovate in una raccolta di gruppi : : : ; ; o . . Inkscape per creare due fumetti sul
profondamente annidata dato che esso : pericoloso, risultando in gruppi nascosti ; Collegamenl:l . web, 'The Greys' e 'Monsters, Inked'

. che non potrete rivelare facilmente o
. gruppi bloccati che non potrete
sbloccare prontamente. Per questa

:  che potrete trovare su:
| Fumetti usatiin questo tutorial, piu |  DEER://www.peppertop.com/
i loro file sorgente di Inkscape, possono

provvede un meccanismo per saltare
indietro di parecchi passi alla volta.
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HOW-TO

Scritto da Ronnie Tucker

Linee guida

deve essere collegato in
qualche modo a Ubuntu o auna
delle sue varie derivate (Kubuntu,
Xubuntu, Lubuntu, ecc).

Regole
* Non c'é un limite di parole per gli

lunghi possono essere divisi in vari
edizioni.

* Per consigli, riferitevi alle Linee
guida Full Circle ufficiali:

http://url.fullcirclemagazine.org/75d4 .« e
. Traduzioni

71

* Scrivi il tuo articolo con qualunque
software preferisci, noi
raccomandiamo LibreOffice, ma non
€ importante. - PER FAVORE
CONTROLLATE L'ORTOGRAFIAE
LA GRAMMATICA!

* Nell'articolo, indicate dove vorreste
che fosse collocata una data
immagine, scrivendo il nome
dell'immagine in un nuovo paragrafo

- oincludendo la stessa nel documento |
. ODT (Open Office).. :
'unica regola per un articolo é che : ;
: «Le immagini devono essere JPG, non
: piu grande di 800 px, e usare una :
. bassa compressione.

* Non usare tabelle o qualsiasi tipodi
. formattazione in grassetto o corsivo.

Se vuoi scrivere una recensione,

o L 2% per favore segui queste linee guida:
articoli, ma vi avvisiamo che gli articoli :

: Quando siete pronti a presentare
- il vostro articolo per favore :
: inviatecelo all'indirizzo email:

. articles@fullcirclemagazine.org

Se ti piacerebbe tradurre Full

Circle nella tua lingua nativa, per

. fFavoreinvia una e-mail a

: ronnie@fullcirclemagazine.org e ti

. metteremo in contatto a un gruppo
: esistente, o ti daremo accesso al testo :
. in Formato grezzo da tradurre. Conil
. PDF completato sarai in grado di

. caricarlo sul sito principale di Full

. Circle.
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Scrivere per Full'Circle Magazine

RECENSIONI

Giochi/Applicazioni

Mentre scrivete recensioni riguardanti i giochi o le
applicazioni, vi preghiamo di essere chiari nello scrivere:

* titolo del gioco

« chi ha creato il gioco

* se e gratis o a pagamento

* dove lo si puo trovare (link download/URL della home page)
* se € un gioco nativo per Linux o avete usato Wine

« il vostro giudizio con un massimo di cinque

* un sommario con punti positivi e negativi

Hardware
Mentre scrivete una recensione riguardante l'hardware per
Favore siate chiari nello scrivere:

* marca e modello dell'hardware

* in quale categoria vorreste inserire questo hardware

« eventuali difetti che si potrebbero incontrare durante ['utilizzo
dell'hardware

* se é facile fare in modo che ['hardware lavori con Linux

* se @ necessario aver bisogno di usare driver Windows

« il vostro giudizio con un massimo di cinque

Non bisogna essere esperti per scrivere un
articolo: scrivete una recensione che
riguarda i giochi, le applicazioni e l'hardware
che usate tutti i giorni.
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Online | Secure Easy

BACKUP |SYNC |SHARING

Whether you need to access a document you have stored
on a remote server, synchronize data between a Mac,
Windows or Linux device, share important business
documents with your clients, or just rest easy knowing all of
your data is safely, securely, and automatically backed up -
SpiderOak’s free online backup, online sync and online
sharing solution can handle all your needs!

SpiderOak offers a different approach to online backup by
combining a suite of services into one consolidated tool -
free online backup, synchronization, sharing, remote access,

= Access all your data in one de-duplicated location and storage. This difference is further measured in our zero-
_ : o knowledge privacy policy - the first one ever employed in
«/ Configurable multi-platform synchronization this setting. Our flexible design allows you to handle data

from any operating system (Mac, Windows and Linux) or
location (external drives, network volumes, USB keys, etc...)
using just one centralized account.

«/ Preserve all historical versions & deleted files
<« Share folders instantly in web ShareRooms w / RSS

«/ Retrieve files from any internet-connected device

«» Comprehensive 'zero-knowledge' data encryption _ _
Download mobile clients

foriUS&AndFOidJ/l G‘-‘t?FfEEGBS

Get 25% off any SpiderOak package
with the code: FullcirclemagFans

« 2 GBs Free / $10 per 100 GBs / Unlimited devices

https://spideroak.com
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https://spideroak.com
https://spideroak.com
https://spideroak.com/mobile
https://spideroak.com

CHIEDI'AL NUOVO ARRIVATO

C iao a tutti! Bentornati a Chiedi al
nuovo arrivato! :

Se avete una semplice domanda
e volete una risposta che non
richieda una conoscenza particolare
come il perché Linus Torvalds questa :
settimana é arrabbiato, contattatemi :
a copil.yanez@gmail.com.

Oggi la domanda e:

Continuo a sentir parlare di
"cloud". Che cos'@ il "cloud"? E
pericoloso? Che odore ha?"

Nel parlare di cloud, mi piace

dare lo stesso saggio consiglio
che mio padre diede a me quando
incontro una strana nuvola in casa:
['ha annusata, ed & morto.

Scritto da Copil Yanez

. di scaricare un file o di archiviarlo su
© una macchina di qualcun altro.

© Giocare, ascoltare la musica,

: memorizzare foto di famiglia, tutto
. pud essere fatto su Cloud.

: passato ore e ore accumulando foto
- della collezione del My Litte Pony.

: Perché dovrei lasciare che qualcun'

- altro li memorizzi per me? A meno
che anche lui fosse un fan?

facendo le cose in Cloud:

Quando si parla di Cloud, si parla

. come Ubuntu One, Dropbox o
. Google Drive.

3. I vostri dati sono accessibili

: ovunque: sei colpita da un ragazzo
. carino che hai appena conosciuto sul

. tuo canale LARP e vuoi fargli vedere

Ma aspetta. Tu dici che hai

Questi sono alcuni vantaggi

1. I vostri dati sono in backup: In

caso di una catastrofica fuoriuscita di
: Four Loko su un computer portatile a :
: un LAN party, tutte quelle divertenti

. jpg sono sane e salve.

Il consiglio non e in realta troppo
lontano. Il cloud puo¢ significare cose
diverse per persone diverse, e il suo
scopo e la sua funzione sono
strettamente associati a coluio a
colei che "annusano" l'azienda o il
programma che offre servizi cloud e
stabiliscono come funzionera in
pratica.

© Anche se si sta attenti a esequire il

: backup dei file su un hard disk o

© stampare tutte le e-mail

© settimanalmente e conservarle in un :
: luogo sicuro come faccio io, non sono :
: ancora al sicuro come avere invece i
© vostri dati replicati su tutti i server

2. | vostri dati sono al sicuro:

come tipico servizio di cloud storage

- il tuo cosplay di Galadriel. Basta

. mettere ['app del tuo servizio cloud

. sullo smartphone, mostrargli le

- immagini e boom, stai uscendo conil
: sosia di Aragon!

4. | vostri dati sono privati: Sei

. l'unico ad avere accesso al libro di
. Jersey Shore che hai creato tu stesso. :
: : indietro la loro roba dal Governo

: degli Stati Uniti. Ma é pil probabile
: che otteniete un massaggio

. completo per il corpo dal TSA, cosi
© non tratterrei il fiato se fossi in voi.

Suona bene, vero?

Beh ci sono alcuni aspetti

: negativi.

: 1.lvostri dati non sono in backup: :
: Sicuro, il vostro servizio preferito
© conservera una copia scansionata del :
: vostro certificato di nascita cosi

. spedite l'originale ai vostri genitori
: perché lo tengano al sicuro. Maiil

vostro servizio cloud e appena
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: MINUTI! | tuoi dati potranno essere
: sottoposti a backup, ma cosa

: significa tutto cio se non e possibile
. accedere al backup? Questo & un

: male. Basta chiedere a Barack

. Obama.

2. | vostri dati non sono al sicuro:

: Lareplica dall'altro capo del mondo &
: fantastica! Finché ognuno dei loro

© server ricevera un mandato di

. comparizione dal Dipartimento di

: Giustizia. Questo e successo

. esattamente al servizio cloud

: Megaupload.com. C'é una remota

possibilita che quegli utenti riavranno

3.1 vostri dati non sono accessibili

: ovunque: Oh guarda, hai un nuovo

tablet! Bene! Si, il nostro servizio non

. e disponibile per quel dispositivo per
© ancora trenta giorni. Scusateci.

: Adesso sei incastrata a vederti col

© tizio che assomiglia a Bilbo.

: andato giu per manutenzione e state :

: per essere insediati come prossimo ~:
presidente degli Stati Uniti tra VENTI

4. | vostri dati non sono privati:
Nessuno ha accesso ai tuoi file.
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Eccetto il governo. E gli ex-
dipendenti insoddisfatti. E gli hacker.
E tua madre ficcanaso.

Ok, quindi siamo stati chiarisu i
pro e i contro? Guardate, la verita e
che i servizi cloud sono grandi e
sempre migliori ogni giorno. Si, ci
sono alcuni pericoli e si deve ancora
eseguire il backup dei file in un luogo
dove solo voi avete accesso. Dove
nascondete i vostri rifornimenti di
sigarette da vostra moglie? Quello
probabilmente & un buon posto per
conservare il vostro disco di backup.

Se siete disposti ad accettare il
piccolo inconveniente di utilizzare
servizi cloud, potrete raccogliere i
frutti di tanti altri che lo hanno fatto.

Per me uno dei principali vantaggi

che potrebbe essere interessante
per i nuovi utenti di Ubuntu é la
possibilita di allontanarsi da un'
installazione disastrosa e
ricominciare da capo, senza
preoccuparsi che i vostri preziosi
ricordi siano andati persi, perché
avete seqguito il suggerimento di
qualche simpaticone di digitare "rm-
rf/" nella riga di comando (Non
fatelo! Fa cose brutte e vi odierete
domani mattina) .

Per mantenere i vostri file piu

G install
o Sign in

importanti, foto, musica e download
in backup, e possibile pulire e

. reinstallare la distro di vostra scelta e :
. semplicemente scaricare i file dalla
. nuvola quando avrete finito.

Non e sorprendente, Ubuntu

. offre un modo semplice per creare
. un po' di archiviazione cloud e iniziare :
© a usarlo quasi subito. Si chiama :
: Ubuntu One, & gratuito e la sua

. configurazione & molto semplice.

Ubuntu 12.10 e dotato di Ubuntu

. One pre-installato e

. caricato sulla sinistra
. del cassetto delle

. app. Trovatelo e fate
. clic sull'icona che

. assomiglia a questo:

Otterrete questa finestra:

Fate click sul pulsate che dice

: "Non ho ancora un account -

. registrami". Passerete attraverso

. alcune procedure di configurazione

. tipiche tra cui un Captcha. Se fallite il
: Captcha, doppio controllo. Potreste

non essere umani.

Ubuntu vi inviera un codice

. segreto (& tutto molto NSA, il tipo di
. cosa devo-sapere). Incollatelo nella

. schermata di registrazione e fate

- click su Avanti. Avrete la possibilita di :
. selezionare le cartelle che desiderate :
. sincronizzare con il Cloud. Suggerisco
. Scrivania e Documenti per lo meno. E :
. possibile aggiungerne altre in
. qualsiasi momento. Fate click su Fine,
. e Ubuntu One iniziera a sincronizzare

ubuntu
one

Select sync folders

Sync, stream, share

| Al Bmsem o s en b sank

rlmm e em
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le cartelle per voi. Richiedera del
tempo a seconda della quantita di

. dati che avete in queste cartelle.

La prossima volta che farete click

sull'icona di Ubuntu One, sarete
. accolti per nome - che € un po'
. inquietante - ma non importa.

D'orain poi, tutto cio che

: aggiungerete nelle cartelle,

. chiederete a Ubuntu One di

. sincronizzarlo e verranno

© automaticamente caricati per essere

disponibili su qualsiasi altro
dispositivo con accesso all'account.
Quindi, se avete iniziato Ubuntu One
sul vostro computer fisso e accedete

. dal computer portatile, avrete

accesso ai file del desktop. Si noti che
non accedete al desktop, ma solo ai

. file che sono stati copiatida li e

. memorizzati nel servizio cloud di

: Ubuntu One. Apportare una modifica
: a uno di questi file consente di

. rifletterle nel file la prossima volta

. che accedete al vostro fisso (o

. ovunque sia).

Se disponete di uno smartphone,

. @ possibile cercare nell'app store

. Ubuntu One e scaricarlo. Una volta

. che accedete con i vostri dati, avrete
. accesso aifile.

Ubuntu One offre finoa 5
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gigabyte di spazio gratuito, ma si puo
pagare se ne avete bisogno di pit. E
possibile memorizzare pureii file
musicali, ma non sara possibile
trasmetterli su un altro dispositivo a
meno che non abbiate

l'aggiornamento del pacchetto Music

Streaming a 3,99 dollari al mese.

Anche nell'aggiornamento della rete

a un totale di 20 GB di memoria &
possibile utilizzarlo per tutto quello
che volete, non solo musica. La
vostra collezione fan-fin erotica di
Justin Bieber e ora al sicuro per
secoli.

Riuscite a sentire questo odore? E

['odore della liberta! Ora potete

pasticciare con la vostra installazione :

di Ubuntu, giocare con le
impostazioni, Fare il dual boot con
['ultima versione instabile, rimanere
svegli tutta la notte, dormire tutto il

giorno e vivere la vite al limite! Non vi
interessa, siete delle rock star! Tutti i

file importanti sono disponibili
semplicemente accedendo a Ubuntu
One!

Giocate con Ubuntu One. Se non
vi piace, e possibile disconnettere il

cloud. La maggior parte avra una
versione gratuita che € abbastanza

file di sincronizzazione e provare con : ©rgeglioso divoi! E giusto per la

qualcosa di diverso, come Dropbox o : Cronaca, di solito era lui a farlo.

Google Drive o qualsiasi altro servizio :

Hi 0% used File Sync is up-
CDpi“ 0 bytes of 5 GiB to-date.

" Get more storage © Disconnect
Folders | Share links ‘ Devices | Settings ‘ Account information |
Go to the web for public and private sharing options @

| My personal folders

& Ubuntu One

Sync Locally?

Always in sync Explore |

Gﬂhﬂpmﬂ

conveniente per la maggior parte
. degli utenti.

Mio padre sarebbe cosi

Buona fortuna, e buon Ubuntu!
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Talktous = K3

3=]

Copil € un nome Azteco che tradotto
letteralmente significa "hai bisogno
del mio cuore per cosa ancora?". Il suo
amore per le scarpe da donna é
raccontato su

anche vedere lui che siimbarazza su
Twitter (@copil)
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LINUX'LAB

D iversi anni fa, sono andato in un
grande magazzino a comprare
un router di fascia media per scopi

personali. Sul lavoro avevamo usato
un paio di vecchi modelli di router di

questa marca, quindi credevo fossero :
. router. Infatti un provider regionale

: offriva un router pre-modificato a

© poco pitl del costo di acquisto di un
© router in un grande magazzino.
cambiare il canale predefinito (abito in :

di qualita piuttosto buona. Ma dopo
meno di 6 mesi ho scoperto cheiil
router calava costantemente nelle
connessioni wireless. Ho provato a

una zona con un elevato utilizzo di
router wireless) ma,
indipendentemente dal canale usato,
dovevo riavviare il router almeno una
volta al giorno. Eseguendo:

sudo iwlist scanning | grep
Cell | we -1

mi vengono mostrate
normalmente tra le 51 e le 85
connessioni, a seconda del giorno e
ora in cui eseguo il comando.

Visto che lavoro per un progetto di

ricondizionamento di computer, ho
deciso di acquistare un router di una

marca diversa per il nostro progetto e

di fare un tentativo. Il router ha
funzionato abbastanza bene, non

faceva cadere le connessioni wireless,

ma purtroppo era carente di

Scritto da Charles McColm

© caratteristiche, come per esempio le
: prenotazioni DHCP. Nello stesso

© tempo in cui tutto questo accadeva,
: sentivo di diversi membri del nostro
: gruppo locale Linux User che avevano :
© mostrandomi le caratteristiche

© integrate: bei grafici di traffico (mi

© innamoro con gli occhi!), Quality of

© Service, filtraggio wireless, restrizioni
: diaccesso, port forwarding, DNS
dinamico e una serie di strumenti.

modificato loro stessi il proprio

La nostra famiglia aveva deciso di

© cambiare provider in ogni caso, e

: prima che potessi comprare il mio
© router, mi ritrovai in mano un router
© Linksys WRT54GL basato su Linux (per :
© tutto il periodo delle vacanze). Il

: firmware disponibile sul WRT54GL,

firmware di Tomato Polarcloud,

A quel tempo stavo pensando di

indirizzo IP statico a un prezzo

© ragionevole, ma anche i permessi per
. implementare il server (nella nostra

5-6 2400

Fropdaand Roawieg
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Tiomato per tutti!

© basato su Linux, non & male, ma uno :
. dei membri del nostro LUG locale, che
© erainoltre un collega di lavoro, mi ha
© convinto a dare un'occhiata al

© zona, i grandi provider scoraggiano gli

utenti domestici ad avviare dei

server). Avrei potuto impostare

: manualmente l'indirizzo IP statico su

. ogni server Linux di casa (abbiamo un

: paio di macchine con XBMCeil

. Game/Web server), ma ho trovato piu
. facile mantenere le macchine in DHCP
. eimpostare la prenotazione IP sul

© router. Impostare la prenotazione IP

. del router vuol dire che anche gli altri

. client dietro il router possono

: . conoscere la macchina/hostname.

- metter su un piccolo server eil nuovo :

: provider non solo mi havendutoun

Il firmware di Tomato Polarcloud

. funziona solo su router particolari. E

: necessario fare attenzione perché,

. perfino all'interno di stessi modelli di

: router, alcune versioni sono

. supportate e altre no. Modificare il

. firmware del proprio router,

: naturalmente, ne invalida la garanzia.
: Come per la modifica del BIOS di un

. computer, l'azione potrebbe rompere
. il dispositivo se interrotta o effettuata
. col firmware errato. Fate attenzione e
. informatevi. Il sito web polarcloud

: http://www.polarcloud.com/tomato
. elencairouter, i modelli e la versione
. particolare di ciascun modello

. supportato. Linksys WRTGS v1 &

" supportato dal firmware di Tomato,
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mentre scrivo questo articolo, ma
Linksys WRTGS v5 non e supportato.

Bisogna stare attenti, perché anche le :
© mi sono preoccupato di resettare il

© router per il MLPPP perché facciamo
: cosi pochi torrent da non risentirne

: molto del traffic shaping.

piccole differenze potrebbero
trasformare il proprio routerin un
fermaporta.

Una volta scaricato il firmware
corretto dal sito web di Polarcloud,

decomprimerlo. All'interno si trovano,

generalmente, diversi file .bin per

diversi modelli di router. Assicurarsidi :
: provider, l'indirizzo che ci ha

leggere il file html readme

scompattato con 'archivio per tutte le :
© opzioni wireless.

informazioni importanti prima di
modificare/aggiornare il proprio
router. Avevo gia modificato il mio
router tempo fa, ma ho notato
all'inizio di questo articolo che il mio
firmware Tomato era di versioni
precedenti. Ho deciso di
modificarlo/aggiornarlo.

La schermata iniziale del firmware
di Tomato sembra qualcosa di simile
alla schermata mostrata a destra.

La prima schermata mostra lo

stato del router. Ho modificato un po' :

l'immagine. | lettori piu attenti
noteranno il messaggio di errore
MLPPP. Il firmware di Tomato € in
grado di gestire il multi-link PPP, che
permette pitl connessioni PPP. E
anche utile per qualche trucchetto,
quale il poter aggirare alcune delle

tecnologie di traffic shaping che taluni
provider utilizzano. Sebbene in casa
siamo oggetto di traffic shaping, non

La maggior parte delle opzioni sul
: lato sinistro del router si espandonoiin :
. ulteriori voci. In Status e possibile

vedere lo stato della connessione al

assegnato il DHCP, nonché le diverse

Nella schermata Bandwidth (in

© basso a destra) si possono vedere

: graziosi grafici del traffico in tempo
. reale e delle ultime 24 ore. Il traffico
: giornaliero, settimanale e mensile &
: espresso totalmente in cifre, ma &

: possibile scegliere di visualizzarlo in
: gigabyte oin megabyte.

Prendete nota delle voci in rosso

© in basso a destra della schermata.
© Qualsiasi elemento sottolineato & _
l'impostazione attuale. Facendo clicsu :
: una delle opzioni adiacenti si cambiera :
- l'impostazione. Premendo sulla parola :
. Line nell'opzione Display, inbassoa
: destra, verra visualizzato il grafico

: come una linea piuttosto che una _
* superficie piena. Nella parte superiore

cisono le schede per le varie
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interfacce del router, tra cui un paio di
porte VLAN.

All'interno della sezione Tools ci
sono una serie di strumenti, uno per
eseguire il ping su un server/sistema,
uno per tracciare il percorso verso un
sistema/server, uno per impostare
['opzione wake-on-lan per i sistemi

all'interno della propria rete e uno per

condurre indagini sulle reti wireless
della zona.

IL RSSI (Received Signal Strenght
Indication), ovvero lo strumento per
verificare la quantita di disturbo e i
canali di altri router, e utile, ma

fatto (e meglio) anche in Linux conil
comando iwlist scanning. Il Wireless
Site Survey non elenca tutti i punti di
accesso wireless nel raggio d'azione.
Nell'esempio di cui sopra solo un
router sta utilizzando il canale 6

dei router qui intorno sono impostati
sul canale 6 come scelta predefinita).

Nel menu Basic > Network é

(DHCP, PPPOE, Statico, PPTP, L2TP, 0

disattivato), l'indirizzo LAN del router
. eccessivo considerato quello che si

* deve fare. E pil facile assegnare le

e le informazioni sulDHCP e la
gamma di IP, cosi come le
impostazioni wireless del router. Se si

LLL e ]

. pensa di utilizzare un servizio DNS

- dinamico, & possibile impostare nel
: menu Basic > DDNS il router per

© comunicare con qualsiasi servizio

naturalmente il suo lavoro puo essere : DDNS che si sta utilizzando.

Il nuovo firmware Tomato offre

. pit di 23 opzioni di servizida un certo :
. numero di fornitori, tra i quali 3322,

- DNS Exit, DNS-O-Matic, DynDNS,

. DYNS, easyDNS, EditDNS, EveryDNS,
(interessante poiché la maggior parte : eNom, FreeDNS, Namecheap,
: OpenDNS, per citarne alcuni.

Il menu Basic > Static DHCP

consente di vedere chiha

possibile impostare tutte le opzionidi : prenotazioni DHCP statiche sulla

base del router: tipo di WAN/Internet :
- inoltre possibile assegnare DHCP

propria rete. In questa schermata e

statici, ma e un lavoro in realta

prenotazioni DHCP nel menu Status >

l s

: Device List, da cui & possibile fare clic
- sulla parola Static sotto l'indirizzo

: MAC del dispositivo. Comunque,

. questa schermata é utile perché il

: menu Status > Device non mostra

- quali indirizzi sono statici.

Se si hanno problemi con una

. particolare persona che continua a

. cercare di accedere al proprio router,
: 0 & stato consentito l'accesso al

: router a qualcuno che ne ha perd

: abusato, & possibile impostare un

. filtro wireless nel menu Basic >

. Wireless Filter. E inoltre possibile

. consentire la connessione wireless

- solo a specifici dispositivi indicandone :
- l'indirizzo MAC sotto alla voce "Permit :
© only...". :

Il menu Advanced ha un certo

. numero di sotto-menu tra cui

Conntrack/Netfilter, DNS, Firewall,
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MAC address (utile se si ha bisogno di
clonare l'indirizzo MAC di un PC

. quando si sta cercando di connettersi

: aun modem utilizzato con un altro

: PC), Routing, Wait time e un paio di

. voci varie. All'interno dei menu

. avanzati ci sono molte cose che

. possono essere finemente

. ottimizzate, come ad esempio

: mettere il router in modalita

. "Afterburner" (detta anche 125 High

: Speed, in pratica una modalita che

. dovrebbe essere il 30-40% pil veloce

© rispetto allo standard 802.11g),

. permettendo al proprio router di

: rispondere ai ping (io lo tengo spento)
. eimpostando i tempi di pausa per TCP
. e UDP.

E all'interno del menu Port

. Forwarding > Basic che ho fissato i

© punti per permettere la

: comunicazione con i servizi del mio

. server. Peril server di gioco, ho

. cercato nei file di configurazione dei
- giochi e nei file Readme per sapere

. quali porte aprire. | motori di ricerca
: sono molto utili per le porte pil
:comuni, se non le si conoscono gia.

Anche nel menu Port Forwarding

© visono le opzioni DMZ, Trigger Port
. Forwarding e PnP/NAT-PMP.

Tomato puo fare il Quality of
Service (QoS). Ilmenu QoS e
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composto dalle impostazioni di base
in cui & possibile assegnare le
percentuali di traffico in entrata e in
uscita per definire le priorita Highest,
High, Medium, Low, Lowest, oltre a
Class A-E. Tali priorita vengono
definite nel menu QoS >
Classification. E inoltre possibile
visualizzare un graficoatortaoi
dettagli del QoS, se € stato gia
impostato e configurato.

Nella nostra casa, il PC di mia
moglie ha la priorita piu alta, seguita
dal traffico DNS tra 0 e 2 KB, quindi
dal traffico WWW compreso tra0 e
512 KB.

Il menu Access Restriction non ha
sotto-menu. Consente diimpostare
regole quali "Spegnere il wireless del
router dalle 23:00 alle 05:00" (utile se
si hanno adolescenti che amano
navigare tutta la notte invece di
dormire).

Se si installa Tomato su un router,
il menu Administration > Admin
Access sara uno di quelli che vorrete
visitare. Nella schermata di accesso
come amministratore e possibile
impostare opzioni quali la password
del router, l'abilitazione per il router

alle comunicazioni SSH (su quale porta

e con quali chiavi), le opzioni di
amministrazione Web e (Yuppy!) le

opzioni Telnet.

Non voglio sembrare troppo

condivisione CIFS (Windows) per fini
di monitoraggio della larghezza di

: : banda. Riguardo a Shutdown
. noioso elencando tutte le voci sottoil :
: menu Administration, quindi ne fard

: notare solo alcune che uso davvero:

. Admin > Configuration, da dove si

. esegue il backup delle configurazioni
. del router da e peri PC. Admin >

: Upgrade, da dove si pud aggiornare il
. firmware Tomato del router (o

© ripristinarlo se si ha gia eseguito un

. backup del vecchio firmware). La voce :
. CIFS Client & intrigante. Quando ci ho
. guardato a fondo, ho scoperto che

. sembra utilizzata per montare la

(spegnimento), Reboot (riavvio) e

: Logout, sono evidenti e quindi non li
. descrivero.

In realta ho soltanto scalfito

leggermente la superficie delle
. opzioni del firmware di Tomato. Non
. ho approfondito molto perché cisono :

: Tomato Firmware page:

. centinaia di opzioni. Se non siete stati . http://www.polarcloud.com/tomato

. mai soddisfatti di un router, dategli un :
. nuovo aspetto con Tomato,

. controllatene la compatibilita (avendo | - farence:

cura di prestare attenzione non solo ai : http://en.wikibooks.ora/wiki/Tomato

Dynamic DNS

IP Address

Dynamic DNS 1

Senvice

URL
Username
Password
Hostname

Wildcard ]
MX,

Backup MX [T
Force Next Update (=

Lse WAN IP Address __. ...

130 (recommended) -

DynDMS - Dynamic -

|I'|T[.' A dynans

auldsbel dyndns_org
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modelli, ma anche ai numeri di
versione) e credo che rimarrete

. soddisfatti della quantita delle

. opzioni disponibili. Vale anche la pena
di verificare il progetto DD-WRT, che

. fa cose simili ma tende a essere piu

. modulare.

. LINK IMPORTANT!:

Wikibooks Tomato Firmware

. Firmware/Menu Reference

. DD-WRT:
http://www.dd-wrt.ca/site/index

=

Charles ¢ un patrigno, marito e fan
di linux che gestisce un progetto non
a scopo di lucro di ricondizionamento
computer. Quando non rompe
hardware/server gestisce un blog su:
http://www.charlesmccolm.com/
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LA 'MIA STORIA

Scritto da 'Blackadder’

a prima volta che ho sentito parlare :

di Linux, credo sia stato cinque anni
¢ "quell'altro sistema operativo."

fa. E avvenuto nella nostra biblioteca
comunale dove é stato installato

Ubuntu in un PC. In questo modo tutte
: conoscenza di cio che significava

Ubuntu. (E lo fa ancora.)

le persone disposte ad imparare
questo nuovo sistema operativo
avrebbero potuto farlo.

Mi ricordo anche molti CD che si
trovavano sul bancone in attesa che
qualcuno li portasse a casa. Eio I'ho

fatto. Credo fosse Feisty Fawn o Gutsy

Gibbon.

La prima volta che ['ho provato
sono rimasto stupito e confuso allo
stesso tempo.

Occorre ricordare che io vengo da
un ambiente solo per Windows. Non
sapevo niente di open source e che
cosa significasse o rappresentasse.
L'unica cosa che sapevo era che era
gratuito e non una copia pirata.

Non dimentichero mai la mia prima
reazione dopo aver visualizzato la

prima volta la schermata: "Ma che .....?"

Era qualcosa che non mi sarei
aspettato. Quella sensazione non mi ha

lasciato per un lungo periodo. Pensavo
sempre ad Ubuntu in quei giorni come

lezioni serali, per conseguire un

: diploma nel settore IT, che mi ha
: rimesso in contatto nuovamente con

: Ubuntu. Ma questa volta con maggiore

Ma mi mancava la conoscenza. La

Dopo averci giocato per qualche

: tempo, me ne sono poi dimenticato per :
: unpo'. :

© entusiasta di Ubuntu. Sia che si tratti

E stato quando ho frequentato le

della versione desktop o di quella
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¢ server, mi piace e lo uso.

Al lavoro ho un mix di postazioni

: : Windows e Apple, ma sono felice di
: approfondimento. Avvenne nel periodo :
© in cui Jaunty Jackalope usci allo :
: scoperto. Fu li, a scuola, che imparai

: molto di piu sul sistema operativo

© stesso, sulle sue funzionalita avanzate,
su come funzionano, e cosi via. Da quel :
: momento, sono diventato un utente

vedere l'introduzione di Linux, per ora

. sul lato server, ma & un inizio. Quando
: guardo indietro alla nostra biblioteca
: comunale ora, sono pitl che felice di

: vedere che tutte le postazioni di

lavoro, pubbliche e private, sono

© passate a un sistema operativo Linux.
Kubuntu, per essere precisi.

Questa, quindi, & la mia piccola

© storia di come sono entrato in contatto
© con Ubuntu. Sono passati alcuni anni, e
: nella maggior parte dei componenti

: hardware in casa ¢ in esecuzione

© Ubuntu e funziona bene. La maggior

: parte delle persone che conosco, in

© questo periodo, stanno considerando

© Linux come loro scelta, quando si tratta
© diinstallare un sistema operativo

© nuovo nei loro hardware. Mi piace

© soprattutto il fatto che non &

© importante se ['hardware & vecchio o

© nuovo. Basta installare il sistema

© operativo e farlo partire. (Questo & un

© ottimo motivo per far in modo che le

. persone utilizzino Ubuntu.)
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Scritto da Ed Hewitt

[ye

Il'inizio di questo mese, Canonical : :
: piattaforma non collaudata. Samsung, :

: Sony e Motorola stanno ottenendo

: grandi successi con Android. HTC sta
: giaguardando a
© due piattaforme
. e Nokia ha

: dedicatoil suo

ha tenuto il suo primo evento
stampa per svelare il suo sistema
operativo per cellulari; Ubuntu per
telefoni. Sul prodotto molti hanno
ipotizzato che sarebbe uscito dopo il
lancio di Unity, fornendo
un'interfaccia 'touch’, dal momento

che Canonical sta portando Ubuntu sui :
: Windows Phone.

: Per Canonical
© non rimangono
. quindichei

dispositivi Android. Mentre Ubuntu
per Android consente al desktop di
Ubuntu di essere eseguito su un

dispositivo smartphone tramite un

computer dock, Ubuntu per telefoni &
: piccoli come

: Huawei e LG.

: Ammesso che si
© trovi un partner
: hardware, il

. dispositivo sara
- valido?

: Hardware

: scadente e

: qualita di

. realizzazione influenzeranno il

: successo di Ubuntu per telefoni.
: Abbiamo visto Samsung scivolare

un sistema operativo completo per
smartphone, nato per sfidare iOS e
Android. Credo che Ubuntu per
telefoni sia morto sul nascere. Fallira.

Una delle prime sfide che
Canonical deve superare ¢ il partner
hardware. | manager di Canonical
hanno dichiarato di aspettarsi gli
smartphone con Ubuntu nel 2014,
tuttavia non ci spero troppo, almeno
finché non ne avro visto uno. Il
mercato degli smartphone &

incredibilmente competitivo. Molti dei
. Windows Phone e questo solo per

: avere un dispositivo con quella
© piattaforma. Potremmo vedere i

grandi produttori fanno fatica a
tenere il passo. Ad esempio, HTC ha
segnalato perdite di trimestre in
trimestre. | produttori di hardware

LA 'MIA OPINIONE

difficilmente punteranno su una

futuro a

produttori piu

negativamente con dispositivi

partener di Canonical fare lo stesso.

. deve superare ¢ il supporto per la

: vendita da parte degli operatori. Le
: compagnie telefoniche possono fare e : )
: disFare il successo mentre Sprint non ha avuto una vasta

¢ clientela per vendere il Palm Pre.

© Anche se molti giornalisti del settore

: ne hanno elogiato sia I'hardware che il
© software, il supporto delle compagnie
© & stato carente e, successivamente,

© Palm e HP hanno lottato per generare
interesse. Potrebbe accadere a

: Canonical.

di un dispositivo.
Saranno loro che
acquisteranno il
telefono dal
produttore
hardware e lo
rivenderanno ai
loro clienti. Se

-4..1‘_"“

552PM

non saranno
interessati.
L'esempio piu

compagnie

ucciso il WebOS.
Dopo aver

: terminato lo sviluppo di HP WebOS,

: Jon Rubinstein (CEO di Palm) & stato
: intervistato da Josh Topolsky di The

: Verge. | dispositivi Palm WebOS sono
© stati acquistati da Sprint e Verizon

© negli Stati Uniti, visto che nessuno

: aveva messo le mani sugli iPhone fino :

a quel momento. Entrambi sono stati
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non crederanno in :

questa possibilita, : , ) .
- sensazionale e ['hardware puo essere

. eccellente, ma se le compagnie non
: sono disposte a vendere e

Famoso di questo commercializzare un dlSpOSItIVO,

& Palm WebOS. Le :
: nessuna parte.

telefoniche hanno

Il prossimo ostacolo che Canonical : ,d'SPOSt' _a.commeraa.hzz_are.e vendgre
- il dispositivo ai propri clienti, tuttavia
: Verizon ha commercializzato in modo

: massiccio il nuovo Motorola Droid

Il software puo essere

Ubuntu per i telefoni non andra da

Canonical potrebbe fare come

: Google che sta vendendo i suoi

: dispositivi Nexus sbloccati, senza

© contratti con le compagnie e sul suo

© sito web. Cio permettera di evitare le
© compagnie. Tuttavia non credo che

© questo possa funzionare. C'é bisogno
- di pesanti azioni di marketing per

© attirare |'attenzione e c'é bisogno

anche di un prezzo competitivo;
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Canonical non potra avere
l'infrastruttura in grado di vendere e
spedire un dispositivo. Hanno bisogno
del sostegno delle compagnie -
soprattutto per colpire il mercato di
massa - e la possibilita di vendere il
dispositivo per il 'pinco pallino' medio.

L'ostacolo finale con cui Canonical

entrera in collisione ¢ il supporto delle
. Canonical?

applicazioni - questo é il tallone di
Achille per tutte le piattaforme
informatiche. Si puo avere una
piattaforma brillante ma, se non si
hanno le applicazioni che la gente
desidera, € una piattaforma morta. Il
motivo di cosi tanto successo per iOS
e Android é che hanno le ‘killer
application' che i clienti desiderano.

Vogliono essere in grado di accedere a
Facebook, ascoltare musica su Spotify, :

guardare film su Netflix, utilizzare la

navigazione con Google Maps, giocare

una partita veloce di Angry Birds. Sia
Blackberry e Microsoft hanno avuto

questo problema ma stanno cercando

di coinvolgere nel loro gruppo gli
sviluppatori per produrre applicazioni
per le loro piattaforme; entrambi

hanno una base di utenti di dimensioni

ragionevoli. Molti sviluppatori hanno
gia detto di non essere interessati a

produrre applicazioni per Blackberry e

Windows Phone. Recentemente,
Google ha detto che appoggera

soltanto Android e iOS. Canonical sta
investendo nella quinta piattaforma

. per gli sviluppatori di applicazioni e
non.riesco adimméginarmeligllavpro . gamma di applicazioni piu diffuse,
: su di essa; questa e ['attuale situazione :
. dei sistemi operativi minori per

. smartphone. Ci sono troppe

: piattaforme che cercano di costruirsi
© un ecosfera. Se gli sviluppatori non

: sono disposti a supportare Microsoft e . dominanti per il prossimo futuro.

© Tuttavia vi & anche il terzo posto, ma

. che & gia occupato da Windows Phone : © . .
- . piattaforme minori; ce ne sono un paio

- in piu:

. +Firefox OS

. +openWebOS
: »Maemo

. *MeeGo

.+ Tizen

.+ Jolla

RIM, perché dovrebbero sostenere

Trovare un partner hardware,

. guadagnare il supporto delle
: compagnie e disporre di una vasta

: questa é ancora la gara da affrontare
. per Canonical. A partire dal dicembre
: 2012, Android e iOS costituiscono

: circail 85% dei S.0. degli smartphone
. del mondo. Saranno le piattaforme
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e Blackberry. Sara un 2013

~ interessante per questi due. Windows
. Phone 8 sara disponibile su piu

. dispositivi, e RIM sara il rilascio

. ufficiale per Blackberry 10. Le

: posizioni quinta e sesta sono

. attualmente detenute da Symbian e

. Bada ed ¢ altamente improbabile che
. si spostino da li. Inoltre ci sono le

. piattaforme smartphone minori, dove
. probabilmente Ubuntu per telefoni si
: assestera. Ecco la lista delle principali

In un mercato in cui Palm e finito,

Blackberry € in calo e lotta per

. soprawvivere, la potenza di Microsoft &
. in grado di scalfire leggermente

. Google e Apple, come pensa Canonical
- di poter sopravvivere? Ha avuto piccoli
. successi nello spazio desktop e server,
. ma credo che questa volta Canonical

. abbia fatto il passo piu lungo della

. gamba.

h- indice ©



UBUNTU
ees USEr

IVIORESUBUN I U:

:_‘ur: '-'.;L': .|“-|le |'|||-“|:llip‘
IWE VE gOL & Whole jot more.
Ubuntu User is your roadmap to the Ubuntu community.

In the pages of Ubuntu User, you'll learn sbout the

latest tools, best tricks, and newest developments
in the Ubuntu story,

UUN L AVIISS IANUTHER IS SUE!

|

Full circle magazine #69 36

ar
The Soltware Centor gets smart

« Wi review
Tunes on :_ilm’n.
& multimedia hiard drives

; v wrorlde
Tux against t
Asliving the 05 Wars it

/SUBSCRIBE-NOW

e y%:

ﬂ- indice ©


http://www.ubuntu-user.com/subscribe-now/
http://www.ubuntu-user.com/subscribe-now/

RECENSIONE

Scritto da Ronnie Tucker

Sony NSZ-GS7 Google TV Box

E ro molto scettico sull'acquisto di
questo media player, per via della
quantita di recensioni negative su di
esso, ma ho deciso di fare un salto nel
buio (in Google) e ['ho comprato
comunque. E sono contento di averlo
fatto!

COSA E INCLUSO NELLA
CONFEZIONE

La confezione e piccola! Mi
aspettavo di ricevere un pacco della
dimensione di un lettore DVD e invece
la scatola di cartone é della dimensione

il box Sony, il telecomando, le batterie
(per il telecomando), cavo di

(ne parleremo piu avanti).

Installazione

- semplice. Inserite il cavo di

. alimentazione e (prima di accenderlo)
. collegate il cavo HDMI. Collegate la

. spina alla rete elettrica e il cavo HDMI
allavostra TV.

: lo uso il Sony Box da solo, ma potete
. collegarlo al vostro decoder del via :
. cavo/satellitare. Cio fain modo da

. controllare la visualizzazione del :
- decoder via cavo/satellitare attraversoil :
. Sony Box, consentendovi difare cose
. fantastiche come picture-in-picture e
- cose simili.

di circa 20x15x10 centimetri. Dentro c'é Conﬁgurazmne

La prima volta che accenderete il

. . T . : Sony Box, esso si associera al
alimentazione e un ricevitore infrarosso :
. telecomando dal momento che

. utilizzano la tecnologia bluetooth. Non
. c'@ bisogno di puntare il telecomando

: ad alcun sensore. Non ne esistono.

. Usare il bluetooth significa che non

Collegare il dispositivo e abbastanza : avete nemmeno bisogno diindirizzareiil :

. telecomando. E un telecomando

HIDIITI .
-

. telecomando, basta premere i pulsanti e
. sara rilevato purché vi troviate dentroiil
. raggio di azione del bluetooth.

Assisterete quindi a una veloce

. presentazione su come usare il

. dawvero speciale (ne parleremo piu
© avanti), basta dire che presenta pulsanti :
. e touchpad su una superficie e una '
. tastiera QWERTY sull'altra.
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Box TV. Fate il login col vostro profilo

. Google, scegliete la lingua, il fuso orario,
- il tipo di connessione a internet (cavo o

. wireless) e la dimensione dello schermo.
. Configurate quindiil ricevitore

. infrarosso.

' Ricevitore infrarosso

Il ricevitore infrarosso € un piccolo

oggetto che trovate dentro la

. Lo . ) . confezione - non dovete utilizzarlo se
Siamo quindi alla configurazione del

non volete, ma vi consente di
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RECENSIONE

comandare un altro box col
telecomando Sony.

almeno cosi pensavo. Avevo puntato il
ricevitore infrarosso al sensore
infrarosso della mia TV. Avendo
configurato il Box Tv Sony dicendogli

anche il numero del modello), adesso

posso accendere e spegnere la TV
usando il telecomando Sony.
Ingegnoso! E stato solo quando ho

capito che il Box Tv comandava la mia

TV solo attraverso il cavo HDMI.
Parleremo di questo tra un momento.

Aggiornamento
Non appena completato il setup e
aperto un pop-up che miinformava di

un aggiornamento disponibile.
Continuiamo!

Dopo l'aggiornamento,

. l'applicazione di Netflix si & installata. .
. , . Uff! Einsieme a essa anche Google Play, :
Inizialmente lo usavo con lamia TV o Chrome (il browser), Live TV (da usare
- solo se connettete la TV aun decoder

. satellitare attraverso il box TV Sony),

. Media Player, Photos (visualizzatore di
AR - - foto), [Google] Play Movies, [Google]

che lamia e una TV Samsung (inserendo Search, Impostazioni, Socialife (sembra
. soltanto Twitter e Facebook), Sony

. Entertainment, Twitter e qualche altro

. programma.

: Ho installato [Google] Play Music per :
. testare lo streaming audio (che funziona :
. bene) e Plex che mi permette di ricevere :
. contenuti in streaming dal mio PCal box :
. Sony. :

Il telecomando

Come ho detto prima, il

notato che il sensore era coperto che ho : telecomando & molto particolare ed &
. stato oggetto di molte critiche in altre
. recensioni, ma tuttavia mi piace! Su una ;
: delle superfici ci sono un po' di pulsanti
. diaccensione/spegnimento (perla TV,
+ l'audio e altro) e altri pulsanti di

. selezione per controllare la TV/PVR.

. Proprio soprail centro € presenteunD-
i .. i padconun pulsante diselezione al
cercato Netflix (che non ho trovato), si & . centro. Su entrambii lati del D-pad sono :
presentii tasti per il Picture-in-Picture,
. Indietro, Home e il menu. Occupando

circa la meta del telecomando é

presente anche un touchpad cliccabile.
: Toccandolo comparira un puntatore

- sullo schermo. Sotto al touchpad ci sono :
. untasto funzione eitastiplay, pausae
. info. Infine ci sono alcuni tasti colorati.
. Girando il telecomando trovereteuna
. tastiera QWERTY! Premendo funzionee :
- ricerca, si attivera la retroilluminazione
- della tastiera, comoda per quelle

. sessioni di navigazione notturna.

Sul lato destro del telecomando ci
sono i tasti del volume, la modalita
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silenziosa e i tasti dei canali. Il
. telecomando é anche sensibile al

movimento per interagire coi giochi.

Video

Non ho provato a

. comprare/noleggiare video con

- Play/Sony, ma di sicuro sia Youtube che
. Netflix funzionano senza problemi e la
. qualita delle immagini € eccellente.
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RECENSIONE

Audio

Anche per l'audio non ho provato
Play/Sony Store, ma alcune tracce sul
mio account Google Play/Music si
sentivano bene dopo aver installato
['applicazione Google Music.

Streaming dei contenuti

La maggior parte dei miei contenuti 5

multimediali sono sul PC Desktop. Per

fortuna visualizzarli sul box Sony é stato
© catalogare i contenuti e recuperare
. metadata e immagini rilevanti.

abbastanza semplice dopo aver
installato Plex (app a pagamento a
meno di 1 £) sia sul PC che sul box Sony.

Plex sul PC & un Media Server che, dopo
: streaming quasi tutti i file audio/video
. che glidate in pasto.

directory da voi selezionate. Dopo dicid :

. Integrazioni

una breve configurazione, scansiona e
cataloga tutto il contenuto delle

Plex rimane in attesa di connessione
verso cui distribuire i contenuti.

Installare Plex sul PC significa
scaricare il pacchetto .deb dal sito
ufficiale (http:;//www.plexapp.com/)
oppure aggiungere il relativo
repository. Una volta installato ancheiil
media player Plex sul box Tv Sony,
facendo clic su di esso si awviera la

dal quale attingerne i contenuti.
Semplicissimo!

Siate pazienti, Plex ci mette un po'a

Plex puo eseguire/mandare in

Recentemente é stata rilasciata

. un'estensione Chrome denominata

. Chromemote

. (http://www.chromemote.comy) che vi
. consente di controllare il box Google TV :
. attraverso il browser Chrome. Per :
. esempio: su Chrome del mio desktop
) ) i : faccio clic sull'icona di Chromemote,
scansione per la ricerca di un server Plex - posso accendere il box Google TV,
- accendere la TV, avendo quindiil pieno
. controllo del dispositivo senza

" nemmeno prendere il telecomando!

Devo dirlo, & impressionante.

: Youtube, pensare "hey, & fichissimo!
. passarlo al box per vederlo sullo
schermo pit grande.

_ Non solo questo, vi fornisce la :
. possibilita di lanciare quasi qualsiasi cosa
- sul vostro box. Potrei avviare un video di :

e

Se avete un ospite 0 un amico a cui

volete mostrare qualcosa, potete
. lanciare una pagina Chrome sul box
: Google TV.

. Conclusioni

; Ho detto molte cose buone del Box :
: Google TV della Sony. Qual & il rovescio
- della medaglia? Le applicazioni.Nonci
. sono molte applicazioni disponibili per
. questo Box TV. Anche se usa Google :
. Play come sorgente di download, sarete
* limitati alle applicazioni il cui :
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funzionamento su Google TV &
riconosciuto. Tuttavia, mentre scrivo

: questa recensione, & possibile installare
. applicazioni via APK. Ci sono molte

. applicazioni utili su Play come AirDroid,
. Evernote e simili.

Spostarsi fra i menu puo sembrare

un po' lento ma non ¢ nulla di grave.
: Puo darsi perché il box utilizza Android
: 3.2enonil fluido Jelly Bean.

Persino con questi aspetti negativi io

sono molto felice. Fa qualsiasi cosa di cui
- ho bisogno e anche di piu. Prima dovevo

usare la mia Xbox per Netflixe TV, eil
mio Acer Revo per lo streaming. Adesso

. ho tuttoin un unico pacchetto.

Se soltanto potessimo avere adesso

un aggiornamento a Jelly Bean, sarebbe
. laciliegina sulla torta!

=

Ronnie ¢ il fondatore e ['editore di Full
Circle, un membro ufficiale di Ubuntu e
un artlsta part t|me i cui lavon possono
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HOME SERVER
2. possibile per qualcuno scrivere
domestico? Dovrebbe utilizzare

Ubuntu (ovviamente), le macchine
dovrebbero fare un avvio dalla rete, i

dati dovrebbero essere disponibili sul
server, come anche Internet. Qualcosa :

che sia poco costoso, fattibile e utile.

Danish Lala

UBUNTU E TROPPO CALDO!

dual boot con Ubuntu LTS 12.04 e
Windows 7, in esecuzione fianco a
fianco. lo sono un grande fan di
Ubuntu, che cerca di fare le cose da
solo su Ubuntu e che cerca sempre di

Ubuntu. Ma ho paurariguardo i
problemi di surriscaldamento di
questo sistema operativo.

Quando lavoro con Ubuntuy, il mio
computer portatile si surriscalda
velocemente, raramente si raffredda
tornando allo stato normale e le
ventole funzionano quasi tutto il
tempo per raffreddare il processore.

N\~ LETTERE

© Tralasciando il rumore della ventola, la :
. batteria dura poco per lo stesso
© motivo. Rispetto a quando il PC lavora :
articoli sulla creazione di un server : conWindows 7, si scarica molto piu
. velocemente quando lavora con

Ubuntu.

Siamo lieti pubblicare ogni mese alcune delle mail che riceviamo. Se

Vorrei che qualcuno potesse

scrivere un articolo sulle soluzioni per
: questo problema. Mi aiuterebbe a
: diventare ancora pit fan di Ubuntu.

Saravanan M

. SCANNING
L mio portatile Dell Vostro 1550 & in :

Gord, a riguardo della tua lista di

. controllo per verificare le nuove

. distribuzioni, potresti aggiungere la
. scansione. Questo era il problema che
: mi haimpedito di abbandonare :
convincere altre persone a passare ad : Windows fino a che, con larrivo di
: Ubuntu 11.04, il mio problema e stato :

 risolto.

Michael Davies

. CHINESE IN LIBREOFFICE

P ochi giorni fa un amico mi ha

chiesto informazioni su come
scrivere in giapponese in LibreOffice.

volete proporre una lettera per questo spazio, di critiche o complimenti,
potete inviarla a: letters@fullcirclemagazine.org. ATTENZIONE: Alcune
lettere potranno essere tagliate per ragioni di spazio.

Gli ho indicato ('articolo di FCM#43

: (Comanda & Conquista di Lucas

Westermann). Ma e tornato da me

. dicendo che non aveva risolto.

: Facendo delle prove, ho scoperto che
© tutto quello che potevo ottenere era
: una fila di rettangoli.

Esattamente come ('autore di

© questo stralcio che ho trovato:

"Anche se l'input in giapponese

. lavora perfettamente su tutto il resto,
: LOrifiuta di mostrare tuttii caratteri
© giapponesi (solo caselle vuote/bianche)
:anche se ho impostato la lingua :
. asiatica predefinita in giapponese e
: attivato l'opzione lingua asiatica."

L'autore aveva una soluzione:

“A quanto pare c'e un altro gruppo

. di opzioni in Strumenti> Opzioni> :
: LibreOffice Writer>Caratteri (asiatica). :
© Cambiando il font in Droid Sans :
:Japanese ha risolto il problema."

: Anche se non ho (ancora) provato, :
: lo stesso metodo probabilmente '
: funzionera per il cinese e coreano
: (usando Pinyin e Hangul).

Brian
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Seguici su: ,

g00.9l/
00.gl/ERTMI

n facebook.com/fullcircle
magazine

twitter.com/#!/fullcirclemag

linkedin.com/company/full-
circle-magazine

i

ubuntuforums.org/forum
display.php?f=270

FuLL CIRCLE MEGAZINE HA

BISOGNO DI TE!

Senza l'input dei lettori Full

Circle sarebbe be an empty
PDF file un pdf bianco (cosa che a
molti lettori non risulterebbe
particolarmente interessante).
Siamo Continuamente alla ricerca di
nuovi articoli, recensioni,
qualungue cosa! Anche piccole cose

desktop ci aiutano a riempire il
periodico.

Date un'occhiata a pagina 24 per
leggere le nostre linee guida.
Seguitele e il successo sara
garantito.

Leggete la penultima pagina (di
ogni uscita) per sapere dove inviare
i vostri contributi.
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-\ FROM THE SUPER FIGHT
N THE CITY!

B I1.‘rl 'i H

1 AJILER 810 S
wFU 1T e tlRca Ty

i

FREPARING TO BATTLE AND CALLING
REALLY BAD NAMES TO EACH OTHER!

SLRRENDER,
WOU TYRANT
 MONCOPOLIST!

SO0ON THEY WERE FACING EACH OTHER,

PIE,

YO NERTISH

EREECOM
FREAK!

ful

THE IT was LAPY PEATH BUS,

WORLE 15 SIR! SHE was TRYING ASAIN

friNE! TO POMINATE ANT ENSLAVE
MANKING! BUT SUDDEMNLY

I'Irr b HE CAME!

i M =

@ F 2

? : / WHE CAMEZ

‘r__h_ —

Look!

IT'S A RRD)
TS A PLANE/
IT'¢ & PEMNSLIMN
FLYIpsE

EUT I CAN SEE
HE WON AT THE ENC
RISHTZ HOW P HE
BEAT HER?Z
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EFENSArORLO

HE DIPN'T HAVE TO, SIR. SOMEHOW,
SHE SIMPLY PARALYZEDR WHEN SHE
WAS ABOUT TO USE HER DEATH RAY.
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D&R

Se avete delle domande su Ubuntu, scrivetecele a questions@fullcirclemagazine.org
e Gordon vi rispondera in un prossimo numero. Si prega di inserire il maggior numero
di informazioni che possano servire a risolvere il vostro problema.

Sto usando LibreOffice Writer
con Ubuntu 12.04 per Powerpc
su un eMac G-4. Ho inserito

esportare in PDF. Un fallimento
totale.

R Installa cups-pdf. Dal menu File
in Writer, seleziona “stampa” e

scegli “pdf” come stampante. Quando -, otile con dual boot. Cosa mi

: suggerite come configurazione del
i partizionamento?

clicchi su “stampa”, verra creato un
file nella cartella PDF nella /home.

Posso usare Kindle per PC sotto : R Assicurati di aver capito seiltuo

Wine?

Si! Dai un'occhiata al terzo post
di questo thread:

http://ubuntuforums.org/showthread installi Windows per primo su un

¢ nuovo disco rigido.

.php?t=1913348

Se sto usando due porte USB,
una peril SO e l'altra per i dati,
come posso sapere qual e quale?

R Apri un terminale e inserisci
questo comando:

sudo fdisk -1

Nella prima linea per ogni
dispositivo, viene mostrata la

; Disk /dev/sdc:
v . . . : 8413773824 bytes
un'immagine da file, poi ho provato ad :

Compilato da Gord Campbell

© capacita, come:

8413 MB,

Ho intenzione di mettere un
hard disk piu capiente nel mio

portatile supportagliIDEoi

SATA prima di fare il tuo acquisto.

E tutto molto pit semplice se

Non sono sicuro che a Windows 8

© piaccia avere una partizione di awio. :
© Se cosi fosse, userei queste partizioni:
© +awio, 100 MB (o quello chevuole
© Windows)

- «Windows, 120 GB

© euna partizione Estesa per la parte

© restante del disco. All'interno di essa:
: +/(che si pronuncia “root”) di 30 GB

" «swap, il doppio della grandezza della

© memoria
: +/home, lo spazio rimanente.

La partizione di root € un po’ piu

Il SO sara tipicamente un codice di grande di quello di cui avrebbe

EL g . . bisogno, ma sarebbe un disastro
. dispositivo piu basso, come sda. :

: immane se si riempisse e ho sentito
. parlare di log di sistema fuori

. controllo che prendono spazio

. abbastanza velocemente. Avere una
. partizione /home separata significa

: che si pud installare una nuova

© versione senza interferire con i dati

: residenti.

Ti suggerisco inoltre di comprare

un box USB per installarci il vecchio
 disco.

C'e un modo perinstallare i
driver ATl per 4670 su Ubuntu

12.10? La 12.04 li prende e liinstalla
: per me immediatamente.

(Grazie a Temujin nel Forum di
Ubuntu) AMD ha eliminato il

. supporto per quella scheda nelle _
© nuove versioni di fglrx/Catalyst. Le tue :
: opzioni sono: :
: 1) Usare un driver open-source
: 2) Usare *buntu 12.04/LTS

3) Riportare alla versione precedente
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il tuo Xserver cosi che il vecchio driver
: Fglrx/Catalyst rilasciato funzioni sulla
:12.10.

D In Kubuntu, c'é un tasto di scelta

rapida per bloccare lo schermo?

Posso impostare che si blocchi dopo
: qualche minuto diinattivita?

R (Grazie a amingv nel Forum di

Ubuntu) La combinazione

predefinita di tasti per bloccare lo

. schermo é Ctrl+Alt+L. Per la seconda

. domanda, si tratta di un'impostazione
- dello screensaver.

D Il mio display fa un po’ di

“sfarfallio” ogni volta che c'e un

movimento sullo schermo. Uso

: Xubuntu 12.10 e ho un processore
Intel Corp di terza generazione,

: controller grafico (rev 09), alias
4000HD. Sembrerebbe essere un

: problema di XFCE.

“Supporto Synk to VBlank peril
composer Xfwm" sembra
aiutare. Guarda qui:

. http://www.webupd8.org/2012/10/xf
: ce-sync-to-vblank-support-for-
: xfwm.html
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C'era un ppa impostato per le
applet e i temi Cinnamon, ma
ora é stato rimosso. Quando lancioiil

Gestore degli Aggiornamenti, ottengo
: secondi sulla sezione di disco EXT4,

percio ovwiamente non ha controllato
: i settori danneggiati.

un messaggio di errore. Come posso
rimuovere il ppa dai miei sorgenti?

(Grazie a Askubuntu) Il

messaggio di errore include il
nome completo del ppa. Usa questo
comando:

sudo add-apt-repository ——
remove ppa:whatever/ppa

(Grazie a John O’Flynn) Uso

LastPass (un add-on per Firefox) :

ed esso ripetutamente visualizza il
messaggio “C'é stato un errore
mentre si cercava di contattare il
server. Per favore controlla la tua
connessione internet.”

R Il problemasi é rivelato essere
una intricata serie di cavi
telefonici trail jack del telefono e il
modem. Quando il modem e stato
inserito direttamente nel jack, tutto
ha funzionato perfettamente.

Su Windows scelgo sempre di
fare una formattazione
lunga/lenta in modo che Windows

possa controllare i settori danneggiati ' , . o
- che ci mette circa 38 minuti.

sul disco. Ho aggiunto un disco rigido

e 'ho formattato, meta come NTFS
per il mio Win7 multi-boot e l'altra

: meta come EXT4, per Lubuntu. La

formattazione ci ha messo solo 2

(Grazie a 3rdalbumdel Forum di

Ubuntu) I moderni dischi rigidi

: sono capaci di determinare i blocchi
: danneggiati per conto loro. Se essi

© vanno a scrivere datiin un blocco e

© trovano che questo blocco &

: danneggiato, essi lo segnano

© automaticamente e scrivono i dati in
un blocco migliore. Tutti i dischi hanno :
© un centinaio di blocchi di ricambio a tal :
© scopo. Se sei preoccupato per i blocchi :
: danneggiati su un disco, controllale
© sue statistiche SMART; Utilita Disco
: pud leggere l'informazione SMART da :
: un disco rigido e trovare quanti :
© blocchi danneggiati sono stati segnati. :
© Se comincia ad avvicinarsi al numero di :
© blocchi di ricambio, occorre copiarei
© tuoi dati altrove e gettare il disco nel
: cestino della spazzatura piu vicino.

Comunque, la OP e persistente e

© usail comando:

. mkfs.ext4 —c /dev/sdb2

C'e un metodo visuale per

_ impostare una cartella condivisa
: su Xubuntu?

Si, installa system-config-samba
cosi come samba. “Samba”

: apparira nelle Impostazioni di Sistema.

Su Ubuntu Server 12.04, con un
indirizzo IP statico, non posso

fare ping verso google.com?

R (Grazie a cheesemill nel Forum di

Ubuntu) Dalla 12.04 in poi non si

potrebbe modificare direttamente
. resolv.conf, poiché viene riscritto dal

sistema. Invece, é possibile
aggiungere la seguente linea al tuo
file /etc/network/interfaces:

: dns-nameservers 192.168.1.1

I@I

Dopo una lunga carriera nell'industria
di computer, anche come redattore
della Computing Canada and
Computer Dealer News, ora Gord e
pil 0 meno in pensione.
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Full Circle Podcast
Episodio 31, Il
Terzo Difficile
Episodio!!

Potrebbe esserci un nuovo
team di podcaster, mail
formato e ancora
lo stesso.

| vostri host:

 Les Pounder

e Tony Hughes
 Jon Chamberlain
* Oliver Clark

<%

Tutti i membri del LUG di
Blackpool (UK)
http://blackpool.lug.org.uk

Olly e Tony vi riporteranno le
ultime novita di quello che
sta succedendo nel “Summer
Break”, Olly parla della sua
installazione Gnomebuntu,
Codeacadamy, e Tony parla
del suo nuovo Nexus 7.
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Scritto da Jennifer Roger

Snapshot

S napshot & un gioco Retro Affect
in stile puzzle/piattaforme. La
storia incarna le avventure di un

adorabile robot di nome Pic. Picé un ,
. oggetti per terminare un quadro. Per:

. esempio, potrete attivare delle leve
: per liberare dei blocchi dalle zone
: senza foto, oppure utilizzare degli
. elefanti volanti come trampolini per :
raggiungere posti sopraelevati.

solitario, armato giusto di una
fotocamera magica in grado non
solo di fare foto ma anche di
eliminarle. Tuttavia c'e un limite di
sole 3 foto, da qui la sfida per
utilizzare in maniera saggia la
propria fotocamera.

La cattura di queste fotografie in :
¢ elementi tipici dei giochi di

© piattaforme. Come in essi infatti, ci
: sono pericoli come palle di fuoco e
coplose plogge di lance. Retro AFFect

tempo reale é il cuore di Snapshot e
permette dirisolvere ogni livello
piazzando e ruotando alcuni cubiin
modo da collezionare oggetti e

raggiungere il proprio traguardo. Gli
ambienti sono abbastanza dinamici e :
Pic sara sovente chiamato ad

interagire con varie creature e

game, ma ci sono anche diversi

e stata abile nel trovare il giusto
rapporto tra un puzzle game e un

. gioco di piattaforme in modo che
: non fosse né troppo facile, né

brutalmente competitivo.

Nonostante ogni livello pud

. essere portato a termine abbastanza :
. completare le centinaia di livelli del
: gioco.

celermente, si e fortemente

. incentivati a rigiocare i livelli per
: portare a termine la scena in maniera:
Snapshot é soprattutto un puzzle : :
. segreti da collezionare e aggiungere
. alla galleria. Basta fare una foto
. dell'oggetto e verra aggiunto in
: automatico alla collezione

completa. Ogni livello ha oggetti

personale. La maggior parte degli
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: oggetti non sono difficili da

. collezionare, ma & molto probabile

. che li cerchiate in ogni luogo per

: battere il punteggio del livello. Oltre
: aguadagnare tutte le stelle, la

: modalita time trial permette di

. battere il proprio miglior tempo.

Tutte queste aggiunte vanno a

| controlli di Snapshot sono pochi
e facili da imparare, la tastiera

. controlla la navigazione e il mouse

: funziona come fotocamera. | pulsanti
. del mouse servono a fare foto e a

. cancellarle, mentre muovere il
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GIOCHI UBUNTU

mouse tutto attorno permette di

avere una visuale migliore su cio che

vi circonda. Effettivamente il
funzionamento delle meccaniche di
controllo necessita di un po' di
dimestichezza perché i comandi
sono un tantino troppo reattivi. Da
una parte é carino che Pic possa
saltare molto in alto con un singolo
clic, ma talvolta e difficile
controllarlo quando la situazione
richiede un po' piu di finezza.

memorie di Rayman e Braid. Tutti e
tre i giochi hanno uno stile artistico
distintivo e gli ambienti sono
colorati e vibranti. Sebbene ci siano
pochi sottili cambiamenti tra i
quattro ambienti, le visuali sono

. magnifiche da osservare. La colonna
: sonora é al pari molto bella, un

. complemento del gioco molto
Esteticamente, Snapshot evoca le

carino.

Snapshot dimostra di essere un

. puzzle game intelligente, con il

© giusto numero di sfide. E carico di
. divertimento e di segreti, oggetti
- collezionabili e, con piu di 100 livelli, :
' : 12.99$ per gioco e colonna sonora.

: dovrete avere molto da fare per non
© tornarci su e guadagnare pil punti. :
: Se non siete stati in grado di

© intercettare per tempo ['ultimo

: Humble Bundle, Snapshot &

. disponibile per il download su _
: retroaffect.com ed & recuperabile su :
: Steam. Libera da DRM, questo :
. gioiello multipiattaforma é venduto

a9.99$ peril solo gioco, ma anche

Pro: Idea divertente, grande
: rigiocabilita, gameplay bilanciato

Contro: Controlli troppo reattivi

x X X X Vs
|[E|

Jennifer é una studentessa di belle arti

della zona di Chicago. Puoi seguire
@missjendie su Twitter oppure visitare
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SALDO DEL 40% PER THE
Book OF GIMP

Per una sola settimana, approfitta
del 40% di sconto de The Book of
GIMP, una guida completa e tutta
a colori per l'editor grafico
gratuito GIMP. In 676 pagine c'é
tutto quello che avreste voluto
sapere su GIMP e molto altro!

ILlibro stampato & abbinato al
formato ebook gratuito (senza
DRM, naturalmente).

Usate come codice di promozione
GIMPMASTER.

Il codice di promozione non puo essere
combinato con altre promozioni.

http://nostarch.com/gimp

@ no starch press
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CERTIEICAZIONE LINUX

Scritto da Richard Philip Witt

[ capitolo 2 del mio libro di studio

LPIC-1 tratta della gestione del
software. In particolare la gestione
dei pacchetti, delle librerie condivise
e dei processi. In questo articolo
tratterd quegli aspetti del capitolo 2
del libro che ho studiato da un mese
ad ora. Mentre scrivo, mi viene in

stabilisce, scusatemi per la mia
parafrasi, che tutto richiede piu
tempo di quanto ci aspettiamo,
perfino quando voi tenete conto
della Legge di Hofstadter.

Per l'esame 101 di LPIC1, dovete
esser familiari sia con la gestione dei
pacchetti Redhat che Debian, cosi

tra i due. Ubuntu, poiché si basa su
Debian, usa dpkg, la suite dei

annoiare con i dettagli ma
essenzialmente si deve imparare a
memoria molte delle opzioni di
comando per la gestione. Per
esempio la differenza tra dpkg -r (-
remove) e dpkg -p (--purge). Dpkg -p
rimuove sia i file di pacchetto che di
configurazione, mentre dpkg -r
rimuove i file di pacchetto ma lascia i
file di configurazione intatti.

. IMPARARE PER L'ESAME 101

: nel dire quanto debba essere
: specifica la vostra conoscenza per
. affrontare questo esame, e questo &
: il responsabile dei miei lenti
mente la legge di Hofstadter, il quale progressua!meno In parte. N,EIm'O
- lavoro quotidiano, non uso né Ubuntu :
© e né qualsiasi altra distribuzione,
: dove potrei mettere in pratica e
- applicare la mia conoscenza su Linux. :
: Inoltre i miei bisogni personalinon
© richiedono di sapere indirizzare molte :
. delle funzioni di alto livello
: necessarie per l'esame 101. Quindi ho :
: prodotto un insieme di flashcard e
come anche conoscere la conversione |mparat9 d n.1emor.|a.‘Le flashcard .
: sono efficaci, ma richiedonoun po'di :
: tempo per essere prodotte. Eppure
. . - : trasferire ripetutamente informazioni :
comandi apt o Synaptic. Non vi posso : dai libri di testo alle flashscard &

: rilassante al massimo per la mente.

Non posso stressare abbastanza

Alla fine dei capitoli del libro ci

: sono delle domande a crocetta, ma

: non sono abbastanza per rilevare le
- lacune della conoscenza e a favorire
. ['apprendimento. Il mio stile di

. apprendimento ha alcune stranezze.

Un caso su questo punto; ho imparato

; cat

: che i due principali file di

© configurazione dell'utente si trovano
© in ~/.bashrc and ~/.profile (altri file di
: configurazione globali si trovano

: altrove). Non so come interpretare i
: contenuti dei file e neppure cosa fare
: con loro, ma conosco dove si trovano.
: Detto questo, la sensazione generale
: che é rimasta dentro di me, & un

. senso di timore riverenziale per la

: complessita del sistema operativo:

: qualsiasi cosa voi vogliate alterare,

© puo essere fatto.

: esempio i codici di errore si

: riferiscono a un numero di linea. Un

: semplice cat -n file.txt > file_lines.txt
¢ produrra file_lines.txt con i numeri di
: linea, (anche le linee bianche sono

: numerate). In alternativa, con un

: piccolo pezzo di codice, lo si pud
stampare direttamente a video con:

-n file.txt.

Ho anche trovato alcuni pezzi di

: conoscenza che sono stati
. concettualmente di grande aiuto. Per :
: esempio, mi sono sempre chiesto

perché i comandi nel pagine di man
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sono numerati? L'angolo in alto a
: sinistra di tutte le pagine di man,

mostra il comando a cui la pagina di

: man si riferisce (per esempio passwd)
: e un numero (per esempio

passwd[1]). In basso alla pagina di
man, a volte, potete vedere il

: comando con piu numeri (per

. esempio password[5]). Questo

: numero si riferisce alla sezione di

: man in cui il comando puo essere

. trovato. Passwd[1] & un comando

. shell e passwd[5] e un formato file: le
. sezioni 1 e 5, nella categorizzazione

: Alcuni comandi, comunque, hanno :
: dato prova di essere molto utili. Per

ella pagina di man, sono 'comandi

. bash e shell' e 'formato file',

. rispettivamente. Come predefinito il
: comando man prende il numero di

. categorizzazione piu basso; se volete
. accedere alla pagine di man per

. passwd collegata ai formati file,

. digitate:

; man 5 passwd.

In breve, ho ancora tanta strada

da fare, ma sto integrando questa
. conoscenze nel mio uso quotidiano.
¢ Tuttavia ho bisogno di trovare piu

risorse.

i‘anceA



Questa é la vostra occasione per mostrare al mondo il vostro desktop o PC. Mandate le vostre
schermate e foto a: misc@fullcirclemagazine.org includendo una breve descrizione del vostro
desktop, le caratteristiche del PC e qualsiasi altra curiosita sulla vostra configurazione.

IL MIO DESKTOP

AFIY " 70N MYEE

Sto usando Ubuntu 12.04 con Unity sul mio Dell Vostro 1510. Lo
sfondo é uno degli sfondi predefiniti. Il tema € Ambiance e il
tema delle icone € ubuntu-mono-dark, uso anche Avant Window
Navigator nella parte bassa dello schermo.

La caratteristica che veramente amo del mio desktop ¢ l'uso di
Conky; potete vedere come mi mostra un sacco di informazioni
del sistema (ora, batteria, CPU, RAM, HDD, LAN, Wifi, ...). Utilizzo
il mio computer ogni giorno per navigare e sviluppare
applicazioni con django.

Specifiche di sistema: Dell Vostro 1510, Intel® Core™2 Duo CPU
T5670 @ 1.80GHz x 2, 2.0 GB RAM, 250 GB HDD.

Javier Guillot Jiménez
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Questo ¢ il mio ultimo desktop KDE. Uso Cairo-Dock. Inoltre, ho
alcuni orologi che mi mostrano l'ora nelle aree dove vivono i
membri della Famiglia. Lo sfondo e una foto che ho fatto ad
Agosto di quest'anno, un fantastico tramonto. Una foto di cui
vado molto fiero.

Specifiche PC:

Processore Intel quad-core Q6600 che gira a 3GHz dal primo
giorno

2 dischi SATA da 500GB, che ultimamente sono molto pieni
4 GB RAM e una scheda grafica nVidia 8500GT

Non e allo stato dell'arte, ma ehy!, ha gia 5 anni e ancora sta
andando forte.

Jan Mussche
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IL MIO DESKTOP

T

R EET ERERET-]- N R

Ubuntu 12.04 personalizzato, a 32-bit, con Unity 3D. Dimensione
delle icone 32 e con uno sfondo dalla collezione di sfondi neri di
noobslab.

Tema Gtk=Ambiance, tema icone=NITRUX-Dark, tema
cursore=DMZ-Black e il tema delle finestre=Ambiance

Ciao, vengo dall'Indonesia. Questo & il mio desktop Uso effetti di Compiz come weebly e il cubo desktop per rendere
Lubuntu 12.04. Guardate il pannello di sinistra, l'ho fatto l'aspetto del mio PC grandioso.
con LXPanel Lubuntu. LXPanel & semplice e grandioso. E :
uso Lubuntu Box Icon. Specifiche Sistema:

Processore: Intel® Core™ i3 CPU 530 @ 2.93GHz x 2
Specifiche PC: Scheda madre: Gigabyte H55M USB3
OS: Lubuntu 12.04 Grafica: Intel® Ironlake Desktop x86/MMX/SSE2
Processore: Dual Core E2200 ; Ram: 4GB
Memoria: 2 GB . HDD:1TB
HDD: Seagate 80 GB Monitor: DELL 19" lcd con 1366x786(16:9) di risoluzione
Resa Cr NAYON
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SOLUZIONE DEL PUZZLE
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gentilmente fornito da, The Puzzle Club -

www.thepuzzleclub.com
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Full Circle Team

Editor - Ronnie Tucker

— ronnie@fullcirclemagazine.org
FCM#69 Webmaster - Rob Kerfia
FULL CIRCLE HA BISOGNO DI TE! Scadenza: admin@°Fullcirclemagazine.org
Una rivista non & una rivista senza articoli e Full Circle non & Domenica 03 Feb. 2013 Podcast - Les Pounder & Co.
un'eccezione. Abbiamo bisogno delle tue opinioni, storie, desktop, how- | Rilascio: podcast@fullcirclemagazine.org

to, recensioni, e qualsiasi altra cosa che vuoi dire ai tuoi compagni utenti Venerdi 22 Feb. 2013
di *buntu. Manda i tuoi articoli a: articles@fullcirclemagazine.org

? COME CONTRIBUIRE
'®

Editing & Proofreading
Mike Kennedy, Lucas Westermann,

Siamo sempre in cerca di nuovi articoli da inserire in Full Circle. Per aiuti e consigli prego Gord Campbell, Robert Orsino,
vedete le Linee Guida Full Circle Ufficiali: http://url.fullcirclemagazine.org/75d471 Josh Hertel, Bert Jerred
Invia i tuoi commenti o esperienze con Linux a: letters@fullcirclemagazine.org : | nqstri ringraziame!‘\ti a Canonical, |
Recensioni hardware/software a: reviews@fullcirclemagazine.org o/ vari team traduttori attorno al mondo

e Thorsten Wilms per il logo di FCM.
" J

Domande per D&R devono andare a: guestions@fullcirclemagazine.org
Screenshot di desktop devono essere inviate a: misc@fullcirclemagazine.org
... oppure puoi visitare il nostro forum via: fullcirclemagazine.org

Ottenere Full Circle Magazine:

I Formato EPUB - Le edizioni recenti di Full Circle hanno un link al file epub nella pagina di downloads. Se hai qualche problema con
il file epub, puoi mandare una email a: mobile@fullcirclemagazine.org

Google Currents - Installa l'applicazione Google Currents sul tuo dispositivo Android/Apple, cerca 'full circle' (nell'app) e sarai in
o grado di aggiungere i numeri dal 55. Oppure puoi fare un clic nel link delle pagine di download di FCM.

| Ubuntu Software Center - Puoi ottenere FCM attraverso Ubuntu Software Center: https://apps.ubuntu.com/cat/. Cerca 'full
circle', scegli un numero, e fai clic sul tasto di download.

@I Issuu - Puoi leggere Full Circle online su Issuu: http://issuu.com/fullcirclemagazine. Per favore, condividi e classifica FCM in quanto
aiuta a condividere al mondo FCM e Ubuntu Linux.

Ubuntu One - Puoi ora avere un numero inviato direttamente al tuo spazio libero Ubuntu One facendo clic sul tasto "Invia a
Ubuntu One", disponibile nei numeri successivi al 51.
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IL GRUPPO ECMITALIANO

L

fU" CErCIe ma ga Zin e " Coordinatori del gruppo: Fabrizio Nicastro - Marco Buono b

) .
vbuntu-it traduzione italiana

Hanno collaborato alla realizzazione di questo numero:

. e
Traduttori: Revisori: Impaginatori:
. ~ | Alessandro Losavio Antonio Allegretti Fabrizio Nicastro
Bianca Kwey Fabrizio Nicastro Mattia Rizzolo

EQ%]G?@ ANCHESIUINEISGRUPPO!

La rivista Full Circle nasce da una idea della Comunita degli
utenti di Ubuntu e vive del lavoro di coloro che hanno scelto di
dedicare parte del loro tempo libero alla riuscita di questo
progetto. E un progetto veramente aperto: tutti possono
collaborare, in un modo o nell’altro. C'é chi scrive gli articoli,
chi li corregge, chi li traduce, chi liimpagina e cosi via.

Anche tu puoi collaborare attivamente alla continua crescita di
questa rivista, il cui unico scopo ¢ la diffusione della cultura
del Software Libero.

Se conosci l'inglese e il Software Libero é la tua passione, puoi
collaborare:

* scrivendo articoli in inglese;

e traducendo in italiano i testi;

* revisionando i testi;

 impaginandoli con Scribus.

Se vuoi saperne di piu, visita la pagina Partecipare del nostro
wiki.
Oggi partecipare e ancora piu facile!

Fabrizio Nicastro
Giuseppe D'Andrea

Jacopo Zilio Paolo Garbin

Marco Buono

Paolo Foletto
Roald De Tino
Valerio Salvucci

Irene Bonta
Jacopo Zilio
Marco Buono
Marco Letizia
Paolo Foletto
Riccardo Padovani
Riccardo Vianello
Valerio Cellentani

| collegamenti per scaricare tutti i numeri di Full Circle
Magazine in italiano li trovi nel nostro Archivio.

Cerchi un articolo pubblicato su FCM?

Nel wiki trovi anche I'Indice generale di tutti i numeri
pubblicati, comprensivo di titolo, autore e pagina
dell'articolo. Fai_clic_ qui per consultarlo!

v
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